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About This Manual

This manual provides an introduction to the Common Desktop Environment
(CDE), a graphical user interface (GUI) that provides an easy method of
interacting with the HP Tru64 UNIX (formerly DIGITAL UNIX) operating
system.

The CDE Companion is divided into two parts:

• Part 1 provides an introduction to the Common Desktop Environment
(CDE) for those users who are not familiar with desktop interfaces.

• Part 2 provides information on migrating from DECwindows Motif to
CDE.

______________________ Note _______________________

In this manual all references to DECwindows refer to the
DECwindows Motif software.

Audience

This manual is divided into two parts and has distinct and separate
audiences as follows:

• The user who is unfamiliar with desktop environments

• The user who wants to migrate from DECwindows Motif to the CDE
environment

For users new to desktop environments, this book provides quick-start
information on logging into the system, navigating in the new environment,
managing the desktop, and using integrated applications.

For users migrating from DECwindows to CDE, this book introduces the new
environment and provides information about how to use CDE to perform
tasks formerly done with DECwindows Motif.

This book should be used along with the Common Desktop Environment:
User’s Guide.

New and Changed Features

The following list describes the major changes made to this book:
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• This version of the operating system provides many new features and
enhancements to its System Management Applications, including a
setup utility. For more information, see the Installation Guide, System
Administration, Technical Overview, the sysman_intro(8) reference
page, and the online help for the applications.

• New figures show commonly used CDE features and integrated
applications.

• Adobe has retired their Display PostScript (DPS) product, which includes
the client libraries, X Server extension, and various applications and
examples. Therefore, HP has also retired the Adobe DPS product from
Tru64 UNIX. No replacements will be available. Customers who have
used the Adobe DPS libraries to develop their own applications will not
have a migration path. The following Adobe applications have been
retired and will no longer be included with the operating system.

– dpsclock

– dpsexec

– draw

– fontview

– makepsres

– pswrap

– scratchpad

– texteroids

– wonderland

– xepsf

– All Adobe fonts under /usr/lib/X11/fonts/Type1Adobe

Support for Adobe Display PostScript (DPS) utilities that depend upon
DPS, such as dxbook, dxmail, dxnotepad, and showps, are no longer
available.

You can use the ghostscript and ghostview utilities instead, which are
available on the freeware distribution media.

The following applications, which use Adobe DPS, have been retired and
will no longer be included with the operating system:

– dxvdoc

– dxbook

– dxnotepad (I18N version in WorldWide Language Support software
in the APCD)
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• You can now access the Netscape Navigator application from the
Personal Applications subpanel on the CDE Front Panel, and startup
instructions are in Section 1.3.2.

• Section 3.1 shows the root user’s SysMan Station Front Panel control.

• Section 3.2.1.4, describes the SysMan Applications Subpanel.

• Section 3.2.2.2 introduces the CDE Window List. This tool, new for
this release, can help you locate application windows across multiple
workspaces.

• Chapter 5 accurately describes current integrated applications. It also
introduces the SysMan Menu and SysMan Station applications, and
the DECterm application.

• Section 8.1 covers information about display-specific sessions.

Organization

This book is organized into ten chapters divided into two parts, and an
appendix:

• Part 1 introduces CDE to those users who are not familiar with a
graphical desktop environment.

• Part 2 provides information on migrating from DECwindows Motif to
CDE.

• Appendix A discusses differences in mail handlers.

Part 1 Introduces the Common Desktop Environment (CDE) and
provides information on getting started in this environment.

Chapter 1 Describes the main components of CDE and describes how to
access the documentation set, online help, and reference pages.

Chapter 2 Provides information on navigating in the CDE desktop
using the mouse and keyboard, and describes how to
start and end a desktop session.

Chapter 3 Provides a tour of the Front Panel and explains how to access
applications, use subpanels, and use workspaces.

Chapter 4 Describes how to use the desktop to manipulate files, access
applications, and customize the environment.

Chapter 5 Provides an overview of the desktop and system management
utilities that are integrated into CDE, and introduces
the SysMan Menu and SysMan Station.

Part 2 Discusses migrating from the DECwindows Motif
environment to CDE.
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Chapter 6 Provides an overview of the common components and
differences between DECwindows Motif and CDE.

Chapter 7 Describes differences between DECwindows Motif and CDE
when starting and ending a session and accessing applications.

Chapter 8 Describes the CDE methods used to customize your desktop
environment instead of using DECwindows Motif.

Chapter 9 Discusses internationalization migration issues in CDE for
those who used these features in DECwindows Motif.

Chapter 10 Describes how to convert DECwindows mail folders and
calendar databases to a format that is understood by the
CDE mail and calendar applications.

Appendix A Describes differences between MH/DXmail and the
CDE mail application.

Related Documents

Icons on Tru64 UNIX Printed Manuals

The printed version of the Tru64 UNIX documentation uses letter icons on
the spines of the manuals to help specific audiences quickly find the manuals
that meet their needs. (You can order the printed documentation from HP.)
The following list describes this convention:

G Manuals for general users

S Manuals for system and network administrators

P Manuals for programmers

R Manuals for reference page users

Some manuals in the documentation help meet the needs of several
audiences. For example, the information in some system manuals is also
used by programmers. Keep this in mind when searching for information
on specific topics.

The Documentation Overview provides information on all of the manuals in
the Tru64 UNIX documentation set.

Reader’s Comments

HP welcomes any comments and suggestions you have on this and other
Tru64 UNIX manuals.

You can send your comments in the following ways:
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• Fax: 603-884-0120 Attn: UBPG Publications, ZKO3-3/Y32

• Internet electronic mail: readers_comment@zk3.dec.com

A Reader’s Comment form is located on your system in the following
location:

/usr/doc/readers_comment.txt

Please include the following information along with your comments:

• The full title of the manual and the order number. (The order number
appears on the title page of printed and PDF versions of a manual.)

• The section numbers and page numbers of the information on which
you are commenting.

• The version of Tru64 UNIX that you are using.

• If known, the type of processor that is running the Tru64 UNIX software.

The Tru64 UNIX Publications group cannot respond to system problems or
technical support inquiries. Please address technical questions to your local
system vendor or to the appropriate HP technical support office. Information
provided with the software media explains how to send problem reports to
HP.

Conventions

The following conventions are used in this manual:

%

$ A percent sign represents the C shell system prompt.
A dollar sign represents the system prompt for the
Bourne, Korn, and POSIX shells.

# A number sign represents the superuser prompt.

% cat Boldface type in interactive examples indicates
typed user input.

file Italic (slanted) type indicates variable values,
placeholders, and function argument names.

[ | ]

{ | } In syntax definitions, brackets indicate items that
are optional and braces indicate items that are
required. Vertical bars separating items inside
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brackets or braces indicate that you choose one item
from among those listed.

cat(1) A cross-reference to a reference page includes
the appropriate section number in parentheses.
For example, cat(1) indicates that you can find
information on the cat command in Section 1 of
the reference pages.
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1
Introducing the Common Desktop

Environment

The Common Desktop Environment (CDE) provides an easy method of
interacting with the operating system. It is a jointly developed graphical user
interface based on industry standards, which include the X Consortium’s X
Window System and the Open Software Foundation’s Motif user interface.
By using the CDE interface, you can use the mouse or keyboard to navigate
and interact with applications.

CDE presents a visual desktop that you can customize. From the desktop, it
is easy to access and manage applications. The desktop itself offers a Front
Panel, a graphical display at the bottom of the screen area that provides
access to applications, printers, and frequently used objects including online
help. It also offers you the option of working in different workspaces. A
workspace is the screen itself, which includes the Front Panel. By using a
control on the Front Panel, you can switch between different workspaces.

This chapter provides a brief overview of the following:

• Logging in and accessing applications

• Managing the desktop and applications

• Locating other sources of information, including the document set, online
help, and reference pages

1.1 Logging In and Accessing Applications

The login screen, displayed by the Login Manager, provides you access to
the desktop. Not only can you enter your login name and password, it also
provides an Options menu where you can select the type of session you want
to begin, and the language to use in your session.

You have the option of starting one of the following sessions:

• A Regular Desktop Session starts the CDE Session Manager after the
Login Manager has verified your login and password. This is the default
desktop. Upon exiting a session, the Session Manager remembers the
state of your last session and restores it when you log in next.
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• A Failsafe Session starts a single terminal window and the Window
Manager. This is useful when you need access to a single terminal
window if there are problems impeding a successful login to a session.

• A Command-Line Session suspends the desktop and provides a way
for you to work in the base operating system environment without
windows. Because the Login Manager is not active and the X server is
not running, a login screen is not displayed.

This section contains the following information:

• Front Panel

• Workspaces

The default language is set by your system administrator; however, you can
also access other languages that are installed on your system. Choosing a
language from the Options menu sets the environment variable LANG for
the duration of your session. The default language is restored when you end
your session. See Chapter 9 for information on using internationalization
features.

1.1.1 Front Panel

The CDE Front Panel is located at the bottom of the desktop. It provides
controls (represented by icons) that start applications, and subpanels that
you can use in your daily work. The Front Panel also provides a workspace
switch, which you can use to move between different work areas. Chapter 3
describes the default applications available from the Front Panel and
discusses how to use subpanels and workspaces.

Figure 3–1 shows the default CDE Front Panel.

Figure 1–1: CDE Front Panel

You can customize the Front Panel by adding and removing controls from
the Front Panel and subpanels, adding and removing workspaces, and
renaming workspaces. If you are familiar with using desktops, you can also
create a Front Panel customized configuration file. See the Common Desktop
Environment: User’s Guide for details on customizing the Front Panel.
For information on creating configuration files, see the Common Desktop
Environment: Advanced User’s and System Administrator’s Guide.
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1.1.2 Workspaces

A workspace is the screen display area. Using CDE, you can move between
different workspaces by using the workspace switch, which is numbered one
through four on the Front Panel. By switching from one workspace to the
next, you can set up multiple work areas. For example, one workspace can
be used for managing mail, another for project management, and so on. The
Front Panel is available in each workspace.

By default, there are four workspaces, but you can add, delete, or rename
workspaces. See Chapter 3 for more information.

1.2 Managing the Desktop and Applications

The desktop has a File Manager, Application Manager and Style Manager.
Each of these provides you with a specific control in the desktop environment.
The following list introduces these controls:

• File Manager

The File Manager provides a view of desktop objects, which includes
files, directories, and applications. All objects are represented by an icon.
Using the drag and drop features of the File Manager, you can easily
manipulate files and directories, and interact with other applications.

• Application Manager

The Application Manager is a special directory (folder) where you can
launch applications and other tools that are available on your system.
Most of the available applications are built into the desktop or installed
automatically, but you also can customize the Application Manager by
adding other applications.

• Style Manager

You can use the Style Manager to customize the appearance of your
desktop. Using the Style Manager, you can control the workspace colors
and palettes, fonts, backdrop patterns, keyboard click and character
repeat, mouse button settings, audio, screen blank and screen lock,
window focus, icon placement, and how your session begins and ends.

See Chapter 4 for additional information on managing these applications
and tools. See Chapter 5 for information about using desktop and system
management applications.

1.3 Obtaining More Information

The documentation is available on line and in hardcopy. You can also obtain
information about CDE from online help volumes and reference pages.

• Section 1.3.1 describes the documentation.
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• Section 1.3.2 explains how to use the Netscape Navigator application to
view the documentation set on line.

• Section 1.3.3 explains how to use CDE online help.

• Section 1.3.4 describes how to view reference pages with the Man Page
Viewer or the man command.

1.3.1 Books, Manuals or Guides

The documentation has three audiences: general user, programmer, and
ToolTalk programmer. The CDE documentation is provided on line only
and not available in hardcopy.

Table 1–1 lists the documents that are intended for the general user.

Table 1–1: User Documentation
Manual Description

Common Desktop Environment:
Advanced User’s and System
Administrator’s Guide

Describes how to perform advanced
customizations of the CDE environment.

Common Desktop Environment:
Desktop Korn Shell User’s Guide

Provides the information you need to
create Motif applications with Korn
Shell (kshell) scripts.

Common Desktop Environment:
Product Glossary

Provides a comprehensive list of terms used
in CDE, and serves as a source and reference
base for all users of the desktop.

Common Desktop Environment:
User’s Guide

Outlines basic features of CDE and explains
how to use the desktop and desktop
applications such as the File Manager
and Application Manager.

Table 1–2 lists the documents that are aimed primarily at programmers.

Table 1–2: Programmer’s Documentation
Manual Description

Common Desktop Environment:
Application Builder User’s Guide

Describes the Application Builder, which
is an interactive tool for developing
CDE applications.

Common Desktop Environment:
Help System Author’s and
Programmer’s Guide

Describes how to develop online help
for application software and integrate
help into an application.

Common Desktop Environment:
Internationalization Programmer’s
Guide

Discusses how to internationalize an
application so that it can be localized to
support various languages and cultural
conventions in a consistent user interface.
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Table 1–2: Programmer’s Documentation (cont.)

Manual Description

Common Desktop Environment:
Programmer’s Guide

Discusses the elements of CDE and
describes how to use them.

Common Desktop Environment:
Programmer’s Overview

Provides overview information on building new
CDE applications, integrating applications
into the desktop, and design issues.

Common Desktop Environment:
Style Guide and Certification
Checklist

Provides application design style
guidelines and lists the requirements
for CDE-level certification.

Table 1–3 lists the documents that are intended for ToolTalk programmers.

Table 1–3: ToolTalk Documentation
Manual Description

Common Desktop Environment:
ToolTalk Messaging Overview

Describes the ToolTalk components,
commands, and error messages.

Common Desktop Environment:
ToolTalk Reference Manual

Describes the Application Interface (API)
components, commands, and error messages
of the ToolTalk service.

Common Desktop Environment:
ToolTalk User’s Guide

Describes the ToolTalk service and how
to modify your application to send and
receive ToolTalk messages.

1.3.2 Viewing Online Documentation with Netscape Navigator

The online documentation set is available in both Hypertext Markup
Language (HTML) and Portable Document Format (PDF) versions.

• You can use the Netscape Navigator application to view HTML or PDF
versions of the documentation. This version of the operating system is
shipped with Netscape Communicator 4.5, which includes Netscape
Navigator. See the Installation Guide for details.

• You can use the Adobe Acrobat Reader application to view PDF versions
of the documentation. See the Adobe Acrobat Reader Online Guide for
information about setting up Netscape Navigator to view PDF files. You
can access this document from the Acrobat Reader Help menu.

To view the online documentation, follow these steps to use Netscape
Navigator:

1. Log in as root or use the su command to gain root privileges.

2. Insert the CD-ROM in your system’s CD-ROM drive.
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3. Use the following command to mount the CD-ROM on
/usr/share/doclib/online if you have only one CD-ROM attached
to your system,

# mount -r -t cdfs -o rrip /dev/disk/cdrom0c /usr/share/doclib/online

If you have more than one CD-ROM device, enter a command similar
to the following to determine the CD-ROM devices connected to your
system. Then, decide which CD-ROM device you want to use.

# ls /dev/disk/cdrom*c

/dev/disk/cdrom0c

/dev/disk/cdrom1c

4. Start the Netscape Navigator from the CDE desktop by using one of the
following methods:

a. Click on the arrow above the Text Editor icon on the CDE Front
Panel to display the Personal Applications subpanel.

b. Click on the Netscape icon.

c. From a terminal emulator window, enter the following command to
run Netscape Navigator in the background:

$ /usr/bin/X11/netscape &

Refer to the netscape(1) reference page for information about
options.

5. Load the home page from the Navigator window by opening the file
/usr/doc/netscape/TRU64_UNIX.html.

6. Select the Documentation bookshelf from the list of options.

7. Click on the Bookmarks menu, then click on the Add Bookmark option
to save this bookshelf for future use.

1.3.3 Online Help

Online help provides detailed information on the CDE interface and
applications.

• From the Front Panel, click on the Help Manager to access a collection
of help volumes.

• To access the help volume from within an application, click on the Help
menu.
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1.3.3.1 Using the Help Manager

The Help Manager is a special help volume available from the Front Panel
that lists all the online help registered on your system. To browse through
registered online help, click on the Help Manager icon. To navigate within
the Help Manager online help volume, click on any underlined topic and use
the help menus and buttons.

The Help Manager icon has an arrow above it, indicating that a subpanel is
available. To view specific help topics about the desktop and Front Panel,
click on the arrow. The subpanel also includes On Item help for the Front
Panel. On Item help is interactive. Clicking on this option turns the pointer
into a question mark (?). Position the pointer over an item in the Front
Panel or a subpanel and then click to view help on that item.

1.3.3.2 Using an Application’s Help Menu

To access help from within a help volume, click on the Help menu. An
online help volume is divided into several sections. Table 1–4 describes the
contents of an online help volume.

Table 1–4: Contents of an Online Help Volume
Menu Item Description

Overview Explains the purpose of the application, how to
start it, and how to exit from it.

Tasks Gives step-by-step examples to illustrate typical
uses of the application.

Reference Describes each window, dialog box, and menu in the
application; may include troubleshooting information.

On Item Turns the pointer into a question mark that you can
click on any part of a window or dialog box to get
help on a specific field or window area.

Using Help Explains how online help is organized and how to use it.

About Application Displays the version and copyright information
for the application.

1.3.4 Reference Pages

Reference pages, often referred to as manpages, provide a synopsis and
description of each command or application on the system. If the reference
page subset is installed on your system, you can use one of the following
tools to access reference pages:

• Section 1.3.4.1 explains how to use keywords to find reference pages for a
command or application.
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• Section 1.3.4.2 tells you how to use the man command to view a reference
page from within a terminal emulator window.

• Section 1.3.4.3 describes the Man Page Viewer, a graphical user interface
(GUI) that lets you view or print a reference page.

1.3.4.1 Finding Reference Pages for Commands and Applications

If you do not know which reference page applies to a command or application,
you can use keywords to help identify the appropriate reference page with
either the man command with the -k flag or the apropos command.

For example, if you wanted to find reference pages related to the GIF
graphics format, you could enter the following:

$ man -k gif
gif2tiff (1) - create a .SM TIFF file from a GIF87 format image file
giftoppm (1) - convert a GIF file into a portable pixmap
ppmtogif (1) - convert a portable pixmap into a GIF file
$

The output shows any reference page with the string gif or GIF in either
the title or the one-line description on the name line. The search is not
case sensitive. The apropos command works the same as man -k, and
the output is identical.

If you want to find the reference page for the command line that invokes the
CDE Session Manager, you could enter the following:

$ apropos session

When you look at the output, you find the following line included:

dtsession (1)- the CDE Session Manager

You can then access the reference page for dtsession(1).

1.3.4.2 Using the man Command

To view a reference page in a terminal emulator window, enter the man
command followed by the name of the command or application you want to
view. For example, to view the reference page for the CDE Session Manager,
enter the following:

$ man dtsession

Refer to the man(1) reference page for more information. See Section 1.3.4.1
for information on finding command and application names by using
keywords.

1.3.4.3 Using the Man Page Viewer

The Man Page Viewer provides a graphical user interface (GUI) that allows
you to view or print a reference page.
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To use the Man Page Viewer to view reference pages:

1. Click on the Application Manager.

2. Double click on Desktop_Apps.

3. View a reference page using one of the following methods:

• Double click on the Man Page Viewer icon and enter the name of
the reference page you want to view. If the reference page name
resides in more than one section (such as the make(1) and make(1p)
reference pages), you can use the format command.section. In the
latter example, you would enter make.1p.

• Drag and drop a reference page icon from the File Manager
onto the Man Page Viewer. For example, if you are viewing the
/usr/man/man1 directory with the File Manager, you can click on
the icon for the file man.1.gz, drag it onto the Man Page Viewer
icon, and release to view the man(1) reference page.

See Section 1.3.4.1 for information on finding command and application
names by using keywords.
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2
Getting Started with CDE

The Common Desktop Environment (CDE) presents a visual desktop that
you can use to interact with the operating system. This chapter introduces
the basic skills you need to perform tasks in the desktop environment. It
then describes how to start, pause, and exit from a desktop session.

This chapter contains the following information:

• Navigating in the CDE Desktop

• Using Windows

• Starting a Session

• Pausing a Session

• Ending a Session

2.1 Navigating in the CDE Desktop

To navigate within the CDE desktop, you can use the mouse or keyboard.
Both provide you with a method of accessing and interacting with the
desktop and applications. The following sections describe the mouse and
keyboard controls.

This section contains the following information:

• Using the Mouse

• Using the Keyboard

2.1.1 Using the Mouse

The mouse is a three-button control connected to your workstation. Moving
the mouse on a smooth surface directs the movement of the pointer that
appears on your desktop. The pointer is shaped like an arrow by default,
but it changes shape depending on the action that is being performed. When
you perform tasks using the mouse pointer, you specify what to act on by
positioning the pointer over that object.

The three mouse buttons determine the type of action that is performed.
By default, mouse button 1 is the left button, mouse button 2 is the center
button, and mouse button 3 is the right button. By pressing and releasing
the mouse buttons, actions occur.
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Mouse button 1 is used typically to do the following:

• Start applications

• Select and manage objects in the desktop or in applications

• Cut and paste text

• Move objects on the desktop

• Change the size of objects on the desktop

Mouse button 2 can be used for copy and paste operations or to move objects.
You can also use mouse button 2 to display the CDE Window List, as
described in Section 3.2.2.2.

Mouse button 3 is used to display and manipulate pop-up menus as described
in Section 2.2.2.2.

When you use the mouse to interact with the desktop and applications,
you often are instructed to perform click, double click, or drag and drop
operations.

• To click on an object with the mouse, point to the object, then press and
release the specified mouse button.

• To double click on an object with the mouse, point to the object, and click
the specified mouse button twice in quick succession.

• To drag and drop an object with the mouse, position the pointer on the
object, then press and hold the specified mouse button while moving
the pointer (and object) to a new position. Release the mouse button to
drop the object in the new location.

See the Common Desktop Environment: User’s Guide for more information
on using the mouse.

2.1.2 Using the Keyboard

You can use the keyboard instead of the mouse to interact with the desktop.
To use the keyboard as a navigator, you combine keys to complete actions.
The following list highlights actions you can perform with the keyboard:

• Start applications

• Select objects on the desktop

• Size objects on the desktop

• Move objects on the desktop

• Manipulate the scroll bars in applications

• Display and select objects
Most of the tasks documented in this chapter can be performed using the
mouse or keyboard, however only examples of using the mouse are provided.
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For instructions on using the keyboard to complete tasks, see the Common
Desktop Environment: User’s Guide.

______________________ Note _______________________

Some of the instructions in this document direct you to use
a specific key or key combination, such as the Delete key or
Alt/F11. If your keyboard does not include a specified key, refer
to your keyboard’s hardware documentation or see Chapter 8 for
information about customizing your keyboard settings.

2.2 Using Windows

When you start most applications, the application is displayed on your
desktop in a framed rectangular window. An application may have more
than one window.

The window itself is your work area or a place to interact with the
application. The window frame has controls that you can use to manage the
window. Window controls consist of a title bar, resize borders, buttons, and
scroll bars. Some windows also have a Menu Bar.

A Menu Bar offers a choice of menus and menu items that you can use to
further manipulate a window or application. Some of the menu items open
dialog boxes. A dialog box is similar to a window and provides you with a
means of interacting with the system or an application.

The following sections discuss window controls and provide information
on managing windows, menus, and dialog boxes. To complete the actions,
you must be familiar with mouse or keyboard techniques. The remaining
sections in this chapter highlight the use of the mouse only.

This section contains the following information:

• Managing Window Controls

• Managing Multiple Windows, Menus, and Dialog Boxes

2.2.1 Managing Window Controls

Usually, a window frame consists of a title bar, resize borders, buttons, and
scroll bars. Table 2–1 highlights these features.
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Table 2–1: Window Controls
Window Control Description

Title bar Displays the name of the application and contains a Window
menu button, Minimize button, and Maximize button.

Click the Window menu button to display the window menu,
then click on menu items to change the characteristics
of the window. Double clicking on the Window menu
button closes (or exits) the application.

Click the Minimize button to turn a window into an icon.
An icon is a graphical representation of an object. To
restore an icon, double click on the icon.

Click the Maximize button to display the window in its
largest size. To restore the window to its original size,
click on the Maximize button again.

Resize border and
corners

Makes a window larger or smaller. Drag either the
border or corner to size the window.

Scroll bars Enable you to view information such as text or graphics
that is not displayed in the current work area. You
optionally can have horizontal or vertical scroll bars, or
both. Slide the scroll bars by clicking on the scroll arrows
or by positioning the pointer over the box in the scroll bar
and dragging it to the location you want.

2.2.2 Managing Multiple Windows, Menus, and Dialog Boxes

When you run an application, a window is opened. Most often, you run
several applications concurrently, thus you have more than one window
opened on your desktop at the same time. Likewise, most application
windows have menu bars, and certain applications open two windows or
provide dialog boxes.

The following sections provide an overview of managing windows, menus,
and dialog boxes.

2.2.2.1 Handling Multiple Windows

Using the window controls is one of the available methods for managing
windows. You also can manage multiple windows using the mouse and
keyboard. The following lists some actions you can perform using the mouse:

• Make a window active by pointing to any part of a window, then click
mouse button 1. You can make a window active by pointing to the resize
borders or title bar, then click mouse button 2. The title bar of the
window changes to indicate that this window is ready for input.

• Move a window or window icon by pointing to the window’s title bar or
icon, then drag the window or icon to a new location.
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• Move a partially hidden window or window icon to the foreground of your
desktop by clicking on any portion of the window or icon.

• Copy text from a window and paste it in another window as follows:

1. Move the pointer to the start of the text you want to copy.

2. Drag the pointer to the end of the text and release the mouse button
which highlights the text you want to move.

3. Point to the location where you want to insert text.

4. Click mouse button 2 to paste the text.

If you decide you do not want to paste the selected text, keep the
pointer in the window that has the selected text, point to an empty
space, then release the mouse button.

See the Common Desktop Environment: User’s Guide for more information.

2.2.2.2 Handling Menus

Menus present you with a list of items that you can use to interact with
windows, applications, and the desktop. Often, a menu item specifies an
action that is to be performed on an object you select. Sometimes a menu
item is dimmed. This indicates that the item is currently unavailable, and is
available only under certain conditions.

Table 2–2 lists the three types of menus.

Table 2–2: Menu Types
Menu Type Description

Pull-down Located on an application’s menu bar, just below the title bar.
A menu bar may contain one or more pull-down menus.

To pull down a menu, click on the menu’s name.

To select a menu item, click on the menu’s name,
then click on the menu item.

Pop-up Present in some applications, desktop objects, and on
the workspace itself. In applications, these menus often
duplicate the items in the pull-down menu. Providing
them in a pop-up menu offers further flexibility when
you are working in applications.

To pop up a menu, click mouse button 3 in an application
window, on a desktop object, or on the desktop.

Option Appear in dialog boxes. Option menus appear as buttons,
and while they can contain more than one item, only
the active option is displayed.
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Table 2–2: Menu Types (cont.)

Menu Type Description

To view all menu items, click on the Option menu (button).

To select a menu item from the Option menu, click on the
Option menu (button), then click on the item.

When you select a menu item followed by an arrow, it opens a submenu.
Select an item in a submenu by clicking on the menu item. When you select
a menu item that is followed by an ellipsis (... ), it opens a dialog box for
additional information to qualify your selection.

See the Common Desktop Environment: User’s Guide for more information.

2.2.2.3 Handling Dialog Boxes

Some applications have dialog boxes. Dialog boxes typically require that
you input additional information before an action is performed. There are
several types of controls that appear in dialog boxes. While some dialog
boxes may use several controls, others may use only one.

Table 2–3 lists controls you may see in dialog boxes.

Table 2–3: Dialog Box Controls
Control Purpose

Text entry box Provides fields for entering requested information. An insertion
cursor shows where to enter text. If the cursor is blinking in a
field, the text entry box is ready for input. If it is not blinking,
click on the text entry box to activate the box. You can delete
characters in these fields by using the Delete key.

Radio button Provides a list of available options. Click on a Radio
button to view options.

Check button Controls on and off settings. Click on a Check button
to turn settings on or off.

Sliders and scales Selects numeric values. Drag the slider or scale to select a value.

List box Provides a menu of options. If a list box has numerous options,
a scroll bar appears. You can select an option by clicking on it.

Push button Used to respond to queries, to indicate how an application is to
handle information you have input, or to offer a set of options.
To perform a push-button operation, click on a push button.

For more information on dialog boxes, refer to the Common Desktop
Environment: User’s Guide.
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2.3 Starting a Session

The Login Manager displays a login screen. The login screen has fields
where you must enter your user name and password. Push buttons at the
bottom of the screen are used to manage your login session:

This section contains the following information:

• Selecting a Language

• Selecting a Session

• Resetting the Login Screen Option

Button Description

OK Indicates that the information you entered is correct.

Start Over Resets the login screen if you enter incorrect infor-
mation or lose your place.

Options Displays the Options menu. The Options menu is used to select
the type of session you want to start and to specify a language.

Help Provides details on using the login screen.

To start a session:

1. Type your user name and press the Return key or click OK.

2. Select the options you want, if any, from the Options menu.

3. Type your password and press the Return key or click OK.

2.3.1 Selecting a Language

The default language for your system is set by your system administrator;
however, you can access other languages that are installed on your system
by using the Options menu as follows:

1. Click on the Options menu.

2. Click on the Language menu item and select a language group.

3. Select a language.

Choosing a language from the Options menu sets the environment variable
LANG. The default language is restored at the end of the session.
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2.3.2 Selecting a Session

Selecting a session determines how your work environment is set up during
your login session. You have the option of starting a Regular Desktop
Session, Failsafe Session, or Command Line Session.

Select a session from the Options menu as follows:

1. Click on the Options menu.

2. Click on the Session menu item.

3. Select the type of session you want to start.

A Regular Desktop Session starts the CDE Session Manager. When you start
a CDE desktop session, a console window and a Front Panel are displayed.
The console displays all system messages received during a session. The
Front Panel provides you access to applications and workspaces. See
Chapter 3 for information on the Front Panel.

A Failsafe Session opens a terminal window and starts the Window
Manager. Logging into a Failsafe Session is useful when you want to execute
commands before starting a desktop session. For example, you may have a
problem that you want to fix before beginning a session.

The Command-line Login Session suspends the desktop and provides a way
for you to work in the base operating system environment, an environment
without windows. Because the Login Manager is not active and the X server
is not running, a login screen is not displayed.

2.3.3 Resetting the Login Screen Option

If you decide that the options you selected are not the ones you want, you
can reset the login screen. Resetting the login screen returns all options
selected back to their default values.

2.4 Pausing a Session
If you plan to be away from your current session for a time, you can pause
your session indefinitely. Pausing your session locks your workstation, but
applications that were started continue to run. Each environment that you
work in offers a different method of pausing a session:

• To pause a Regular Desktop Session, click on the Lock control on the
Front Panel.

• To pause a Failsafe Session, type the dxpause command at the command
line prompt.

When you pause your session, a blank screen is placed over the workstation
screen and a dialog box is displayed stating that the display is locked.
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You have the option of displaying other screen savers by using the Style
Manager. Enter your password in the text entry box to resume your session.

2.5 Ending a Session

Each environment that you work in offers a different method of ending a
session:

• To end a Regular Desktop Session, click on the Exit button on the Front
Panel. A dialog box appears that asks you to confirm the end of session.
You can choose to continue with the log out process, cancel the logout
process, or select help.

All settings from this session are saved and restored during your next
session, including all applications that support save and restore. That
is, all applications that are opened when you exit a session, which
support save and restore, are opened when you log in again. For some
applications, all the work is restored, while for others, only the main
screen of the application is restored.

If you changed your startup options using the Style Manager Startup
control specifying other options, the state of your next session depends
on your selection.

• To end a Failsafe Session, type the exit command at the command line
prompt in a terminal emulator window.

• To end a Command Line Login Session, type the exit command at the
command line prompt.
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3
Using the Front Panel

The Front Panel is the horizontal display located at the bottom of your
workspace. It displays the controls (or tools) that you use to start
applications, manage tasks in a desktop session, or change workspaces.
Each control is represented by an icon that indicates its purpose.

This chapter provides descriptions of the controls available by default on the
Front Panel and discusses how to use subpanels and workspaces.

This chapter contains the following information:

• Touring the Front Panel

• Using Front Panel Menus and Workspaces

3.1 Touring the Front Panel

By default, the Front Panel provides several controls that you can use
to manage your desktop sessions. Some controls, such as the Clock, are
indicators only. Indicators do not perform actions. Others, such as the Mail
control, perform actions. That is, you can use mail to send and receive
messages.

Figure 3–1 shows the default CDE Front Panel.

Figure 3–1: CDE Front Panel

The available Front Panel controls are described in Table 3–1. For detailed
information on the use of each tool, see the Common Desktop Environment:
User’s Guide.

Table 3–1: Front Panel Controls
Application Use of Application

Clock Displays the time of day in analog format. Clicking on
this control does not perform an action.
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Table 3–1: Front Panel Controls (cont.)

Application Use of Application

Calendar Displays the current month and day. Use this application
to schedule appointments and To Do Items, set reminders,
browse other calendars, and schedule group appointments.
Dropping an appointment file on the Calendar control adds
the appointment to your calendar database.

File Manager Provides a view of directories (folders) and files.
Dropping a directory on the File Manager control
opens a view of that directory.

Text Editor Opens a Text Editor window where you can create letters
or notes. Dropping a file on the Text Editor icon opens
that file in a Text Editor window.

Mailer Starts the Mailer application. Use this application to
send, receive, save, and forward mail messages. Dropping
a file on this control displays a new message window,
with the file dropped in as an attachment.

Lock Pauses a session indefinitely. Pausing a session locks the
workstation display, but applications continue to run. To
resume a session, enter your password.

Workspace Switches Changes workspaces. Use this switch to move to different
work areas. There are four workspaces by default.

Busy Light Indicates that an action is being performed. For example,
when you start an application, the light blinks. Once the call
to the application is complete, the busy light stops blinking.
Clicking on this icon does not produce an action.

Exit Starts the logout process for a session.

Printer Displays the status of the default printer. Dropping a file on
the Printer icon prints that file on the default printer.

Style Manager Opens the Style Manager application. Use this application
to change the characteristics of your environment.

Application Manager Starts the Application Manager, which is a container for
applications and other tools available on your system.

SysMan Station Starts the SysMan Station, a graphical system map that
lets you visually select system components and run SysMan
applications that apply to those components. Available only if
you are logged in as root. Figure 3–2 shows a portion of the
CDE Front Panel that includes the SysMan Station Control.
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Table 3–1: Front Panel Controls (cont.)

Application Use of Application

Help Manager Displays the top level of available online help information.
Dropping a master help volume file (*.sdl) onto
the Help Manager opens a help viewer window and
displays the contents of that volume.

Trash Can Opens the Trash Can application. Use this application
to delete files. Dropping a file on the Trash Can control
moves the file to a discard directory.

Figure 3–2 shows the SysMan Station control on the CDE Front Panel. This
is available only if you are logged in as root.

Figure 3–2: SysMan Station Control on CDE Front Panel

3.2 Using Front Panel Menus and Workspaces

Some Front Panel controls have arrows above them, indicating that a
subpanel is available. A subpanel is a menu that provides access to other
controls, which you can use to manage your desktop session. Section 3.2.1
provides more information and describes the default subpanel menus.

All controls on the Front Panel have a pop-up menu that you access by
pointing to the control and clicking mouse button 3. Usually, pop-up menus
contain a control that you can use to add or remove a subpanel, and a control
to view an online help volume. Controls, that perform actions, such as the
Text Editor, also provide a control on the pop-up menu that you can use to
start that action from the menu. Refer to Table 2–2 for general information
on using menus.

You can use the Workspace Menu to manage workspaces. The workspace
menu is a pop-up menu used to manage windows, the Front Panel, and
more. Section 3.2.2.1 tells you more about the Workspace menu.

The CDE Window List lets you quickly locate an application window among
many open windows in multiple workspaces. Section 3.2.2.2 explains how to
use the CDE Window List.
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This section contains the following information:

• Using Subpanel Menus

• Using Workspaces

3.2.1 Using Subpanel Menus

Subpanel menus provide you further access to other tools and controls for
the Front Panel. Each subpanel on the Front Panel also provides an Install
Icon control to add other tools to the subpanel.

By default, there are three subpanels available from the Front Panel.
They are the Personal Applications, Personal Printer, and Help Manager
subpanels. To open a subpanel, point to a control icon that has an arrow
above it, then click on mouse button 1. If you are logged in as root, you
also may have access to the SysMan Applications Subpanel located above
the SysMan Station control on the Front Panel.

The following sections discuss the default subpanels. For more information
on using and customizing the subpanels, see the Common Desktop
Environment: User’s Guide.

3.2.1.1 Personal Applications Subpanel

The Personal Applications subpanel contains applications that you use
frequently. It is located above the Text Editor control on the Front Panel.
Figure 3–3 shows the Personal Applications subpanel.

Figure 3–3: CDE Personal Applications Subpanel

The menu items available on this subpanel include:

• Install Icon
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Use this control to add items to the Personal Applications subpanel.
To add an item, drag an item from the File Manager or Application
Manager onto the Install Icon control, then release. The item is then
added to the subpanel.

• Text Editor

Use this control to create text files such as notes and messages. This
control is a duplicate of the Text Editor control available on the Front
Panel.

• Terminal

Use this control to start the dtterm terminal emulator, which emulates
the portion of a VT220 terminal that is consistent with ANSI and ISO
standards. You can use the terminal emulator to enter UNIX commands,
copy and paste text, or communicate with remote systems.

_____________________ Note _____________________

In certain locales, the DECwindows Motif terminal emulator
dxterm is available on this subpanel instead of dtterm. Refer
to Chapter 9 for more information.

• Icon Editor

Use this control to create or modify icons and backdrop images in bitmap
or pixmap format.

• Netscape

Use this control to launch the Netscape Navigator application.

3.2.1.2 Personal Printers Subpanel

The Personal Printers subpanel lists default printers. It is located above the
Printer control on the Front Panel. Figure 3–4 shows the Personal Printers
subpanel.
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Figure 3–4: CDE Personal Printers Subpanel

The menu items include:

• Install Icon

Use this control to add items to the Personal Printers subpanel. To add
an item, drag an item from the File Manager or Application Manager
onto the Install Icon control, then release. The item is then added to
the subpanel.

• Default

Use this control to display the status of print jobs on the default printer.
If you drag and drop a file on this menu item, the job is printed on the
default printer or a printer of your choice. This control is the same as
the Default Printer control on the Front Panel.

• Print Manager

Use this control to obtain a view of available printers on the system.

3.2.1.3 Help Subpanel

The Help Manager subpanel lists other available help volumes. It is located
above the Help Manager control on the Front Panel. Figure 3–5 shows the
Help Manager subpanel.
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Figure 3–5: CDE Help Manager Subpanel

The menu items include:

• Install Icon

Use this control to add items to the Help Manager subpanel. To add
an item, drag an item from the File Manager or Application Manager
onto the Install Icon control, then release. The item is then added to
the subpanel.

• Help Manager

Use this control to display the top level of help information. This control
is the same as the Help Manager control on the Front Panel.

• Desktop Introduction

Use this control to display the introductory help volume for the desktop.

• Front Panel Help

Use this control to display help for the Front Panel.

• On Item Help

Use this control to obtain on-item help for controls in the Front Panel. To
obtain on-item help, click on the On Item Help control. The pointer turns
into a question mark (?). Position this question mark over an object on
the Front Panel, then release. Help is then displayed for that object.

3.2.1.4 SysMan Applications Subpanel

The SysMan Applications subpanel lists System Management Applications.
It is located above the SysMan Station control on the Front Panel. Both the
SysMan Applications subpanel and the SysMan Station control on the Front
Panel are available only if you are logged in as root.
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Figure 3–6 shows the SysMan Applications subpanel.

Figure 3–6: SysMan Applications Subpanel

• Install Icon

Use this control to add items to the SysMan Applications subpanel. To
add an item, drag an item from the File Manager or Application Manager
onto the Install Icon control, then release. The item is then added to
the subpanel.

• SysMan Station

Use this control to start the SysMan Station, a graphical system map
that lets you visually select system components and run SysMan
applications that apply to those components. This is available only if
you are logged in as root.

• Daily Administration

Use this control to access applications used for frequently performed
system administration tasks.

• Configuration
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Use this control to access applications used to configure a system after
installation. Ordinarily, you will not need to use these applications once
your system is set up.

• Monitoring/Tuning

Use this control to access applications used to monitor and tune your
system after it is up and running.

• Software Management

Use this control to access applications used to install and manage
additional software on your system.

• Storage Management

Use this control to access applications used to monitor and manage file
sytems.

• Tools

Use this control to access applications used to display a variety of system
statistics with the Display Window application. You can repeatedly
display the same statistics to monitor progress or trends.

• SysMan Menu

Use this control to access the SysMan Menu, a hierarchical menu of
system management tasks that can be used in several different user
environments.

3.2.2 Using Workspaces

Workspaces offer you a method of organizing your work into categories. Use
the workspace switch on the Front Panel to move between workspaces. By
default, the workspace switch has four buttons, labeled One, Two, Three, and
Four. To move between workspaces, click on one of the workspace buttons.
Figure 3–7 shows the workspace switch.

Figure 3–7: CDE Front Panel Workspace Switch
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Each workspace offers you a view of the Front Panel. Thus, you can easily
locate applications and tailor each workspace to suit your needs. Often it is
useful to rename a workspace. To rename a workspace:

1. Click on the workspace button that you want to change. The workspace
selected is displayed.

2. Click on the workspace button again. This changes the button to an
input text field.

3. Enter the new name in the text field and then press the Return key.

You also can use the workspace button pop-up menu to rename, add, or
remove workspaces. To use the workspace button pop-up menu:

1. Point to the workspace button that you want to change and press mouse
button 3.

2. Choose the option you want from the pop-up menu.

If you add a workspace, it is labeled New. You can rename the workspace
using either of the previous methods.

If you remove a workspace that contains windows, the windows are moved to
the next workspace. If it is the last workspace and it has windows, removing
the workspace causes all windows to be moved to the first workspace (labeled
one by default).

3.2.2.1 Using the Workspace Menu

CDE provides a Workspace menu. The Workspace menu is a pop-up menu
that contains items for managing each of your workspaces. To open the
Workspace menu, point to any blank area on your screen and click and hold
mouse button 3. Figure 3–8 shows the CDE Workspace Menu.

Figure 3–8: CDE Workspace Menu

Use the Workspace menu to:
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• Raise or lower windows relative to each other

• Refresh the display

• Minimize or restore the Front Panel

• Consolidate scattered icons in the Workspace

• Restart the Window Manager (especially if you have customized
configuration files)

• Log out of the session

You can customize the Workspace menu by adding or removing items as
you choose. See the Common Desktop Environment: User’s Guide for more
information.

3.2.2.2 Using the CDE Window List

CDE provides a Window List to help locate application windows in your
Workspaces. Use either of these methods to open the CDE Window List:

• Point to any blank area on your workspace backdrop and click mouse
button 2.

• Press the Alt/F11 key combination.

Figure 3–9 shows the CDE Window List.

Figure 3–9: CDE Window List
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The CDE Window List lets you quickly locate an application window among
many open windows in multiple workspaces. Use the CDE Window List to:

• Find an application window

• Show the icon image, location, and state of an application window

• Go directly to an application window from the CDE Window List

• Sort the list of application windows by title, class, workspace, or time
created (most recently used at the bottom of the list)

• Search for application windows by title, class, or workspace

See the online help volume for detailed information on using the CDE
Window List. To access the online help volume, start the CDE Window List
and click on the Help button.
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4
Managing the Desktop and Applications

This chapter provides information on managing your desktop and
applications. The CDE desktop provides a File Manager, Style Manager, and
Application Manager. Each provides you with a method of managing and
customizing your desktop environment.

• Use the icon-based File Manager to manage directories (folders) and files
on your system, see Section 4.1. You can create new directories and files,
locate directories and files, and remove directories and files. Because
it is integrated with the desktop, you can drag objects from the File
Manager to use in other applications.

• Use the Application Manager to access other tools that are available on
your system, see Section 4.2. From the Application Manager, you can
start applications or move applications to the Front Panel.

• Use the Style Manager to customize the appearance of your desktop,
see Section 4.3. You can change colors, background patterns, window
attributes, mouse and keyboard attributes, and choose how your session
begins and ends.

The following sections discuss in more detail how to use the File Manager,
Application Manager, and Style Manager.

4.1 Managing Files and Folders

The File Manager is an application that you can use to manage directories
(folders) and files on your system. A directory can contain subdirectories,
files, and applications, and each is represented by an icon in the File
Manager. The structure of directories under the File Manager is the same
as the structure in a nongraphical environment. In fact, you can display
files by name only.

When the File Manager is started, a window is opened that displays the
current directory path, menus, a viewing area, and the directory contents,
represented by icons in the viewing area. A status line specifies the number
of objects in the directory you are viewing. Figure 4–1 shows the CDE File
Manager.
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Figure 4–1: CDE File Manager

By using the File Manager menus, you can change, move and rename
directories and files. You also can perform actions on certain files or specify
how they are viewed. The following sections discuss the options available
in the File Manager menus. For more information on other methods of
managing files, see the Common Desktop Environment: User’s Guide.

This section contains the following information:

• Using the File Manager File Menu

• Using the File Manager Selected Menu

• Using the File Manager View Menu

4.1.1 Using the File Manager File Menu

Use the File menu to rename directories or files and to move directories
and files within the File Manager. Table 4–1 shows the selections in the
File Manager’s File menu.
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Table 4–1: File Manager File Menu
Menu Item Purpose

New Folder... Opens a dialog box that you can use to create new
directories. If you do not specify a pathname, the directory
is created in the current directory.

New File... Opens a dialog box that you can use to create new files. If you
do not specify a path, the file is created in the current directory.

Go Home Changes to your home directory. The viewing area displays
all files and directories in your home directory.

Go Up Changes to the Parent Folder. That is, the view changes
to the directory above your current display.

Go To... Opens a dialog box where you can specify the
directory you want to view.

Find... Opens a dialog box where you can specify a directory or file that
you want to locate. Wildcards are permitted in directory and
file specifications. If you do not know the name of the file, you
can specify a search by file content. Files that are located are
listed by name. You have the option of placing the file on the
workspace or viewing the contents of the file in the File Manager.

Open Terminal Opens a terminal emulator window. You can use this
window to create new files or perform other tasks
related to file management.

Close Exits from the File Manager.

4.1.2 Using the File Manager Selected Menu

Use the Selected menu to perform actions on specified directories or files.
You first must select a directory or file before initiating an action. To select
a directory or file, click on your selection in the File Manager window.
Table 4–2 shows the selections in the File Manager’s Selected menu.

Table 4–2: File Manager Selected Menu
Menu Item Purpose

Move To... Opens a dialog box that you can use to move a
directory or file to a new destination.

Copy To... Opens a dialog box that you can use to copy a
directory or file to a new destination.

Copy as Link... Opens a dialog box that you can use to copy a directory
or file to a new destination, which is to be used as a link.

Put in Workspace Places the selected directory or file in the workspace.

Put in Trash Marks the selected directory or file for delete.
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Table 4–2: File Manager Selected Menu (cont.)

Menu Item Purpose

Rename... Opens a dialog box that you can use to specify a
new name for the directory or file.

Change Permissions... Opens a dialog box that you can use to change the
permissions on the selected directory or file.

Select All Marks all directories and files in the current
directory for an action that you specify.

Deselect All Causes all directories and files marked for an
action to be unmarked.

Open in Place Displays the contents of the directory or file in
the current File Manager window.

Open New View Displays the contents of the directory or file in
a new File Manager window.

Print Submits to the print queue the selected directory or file.

4.1.3 Using the File Manager View Menu

Use the View menu to manipulate how directories and files are displayed.
Table 4–3 shows the selections in the File Manager View Menu.

Table 4–3: File Manager View Menu
Menu Item Purpose

Open New View Opens a new File Manager window.

Set View Options... Opens a dialog box that you can use to specify the format
of headers, placement of files, and how they are viewed.

Save as Default Options... Opens a dialog box that you can use to save the
current settings for the File Manager.

Show Hidden Objects Displays all hidden directories and files in
the current directory.

Set Filter Options... Displays the Set Filters Options dialog box,
which you use to specify files you want hidden
based on data type or name.

Clean Up Sorts and arranges objects in the current directory
into columns and rows.

Update Refreshes the File Manager display adding any
new directories or files that have been created
since the application was started.
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4.2 Managing Applications

The Application Manager is a container for applications and other tools on
your system. Applications are placed under the Application Manager when
your system is installed, the system administrator adds them, or you can
add them to this area. Figure 4–2 shows the CDE Application Manager.

This section contains the following information:

• Accessing Built-in Application Groups

• Using the Application Manager Menus

• Running an Application from the Application Manager

Figure 4–2: CDE Application Manager

4.2.1 Accessing Built-in Application Groups

When you start the Application Manager, a set of application groups is
displayed in the main window. Each application group is a directory that
can contain one or more controls or subdirectories.

The default application groups are as follows:

• Conversion_Tools

Contains applications to migrate the DECwindows Calendar to the CDE
Calendar, and to convert mail folders from dxmail format to CDE’s
dtmail format. See Section 10.1 for information on converting your
mail folders.

• Desktop_Apps
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Contains the desktop applications such as the File Manager, Style
Manager, and Calendar applications.

• Desktop_Tools

Contains commonly used tools for desktop administration such as the vi
text editor, Check Spelling, and Reload Application.

• Information

Contains icons that represent frequently used help volumes.

• System_Admin

Contains the tools used by a system administrator to manage the system.

4.2.2 Using the Application Manager Menus

The Application Manager is actually a File Manager view of a special
directory on the system. Unlike the File Manager, the directories and
controls in this view group applications in related groups, and all files
contained in these groups are data files, read me files, templates, and
actions. The menus for both the Application Manager and File Manager are
closely related. For information on using the Application Manager menus,
see the descriptions of the File Manager menus in Section 4.1.

4.2.3 Running an Application from the Application Manager

To run an application from the Application Manager, double click on the
application group’s icon to display the contents, then double click on the
application that you want to start.

4.3 Customizing Your Environment

The Style Manager is an application that you can use to customize your
environment. When the Style Manager is started, a window is opened
that displays several controls. Each control is represented by an icon,
and collectively these are used to customize screen appearance, system
characteristics, and startup and logout behavior. Each control opens a
dialog box that offers a variety of options. Figure 4–3 shows the CDE Style
Manager.
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Figure 4–3: CDE Style Manager

The Common Desktop Environment: User’s Guide provides detailed
instructions on using the Style Manager. The following sections discuss
these options.

This section contains the following information:

• Changing Screen Appearance

• Setting System Characteristics

• Specifying Startup and Logout Behavior

4.3.1 Changing Screen Appearance

The Style Manager provides three controls that you can use to change the
appearance of your workspace. These include the Color, Font, and Backdrop
controls.

Use the Color control to set the colors displayed by windows and applications.
A default list of color palettes is provided, and each can be previewed before
being applied to the desktop.

By using the color control, you can do the following:

• Select a palette

• Modify an existing palette

• Choose a color from the workspace

• Create a custom palette

• Delete a palette

• Change the number of colors used on the desktop

Use the Font control to change the size of fonts used by your applications and
windows. The fonts available to you are determined by your display type.

By using this control, you can preview all selected fonts before applying
them to the desktop.

Use the Backdrop control to change the background pattern of your
workspace. This control provides a list of several patterns that you can
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choose from and each can be previewed in a viewing area before you apply
them to the desktop.

If you prefer to view the root window, select the No Backdrop option.

4.3.2 Setting System Characteristics

The Style Manager provides five controls that you can use to set system
characteristics. These include the Keyboard, Mouse, Beep, Screen, and
Window controls.

Use the Keyboard control to set the key click volume and character repeat
capability. The key click volume determines how loud key clicks are as you
type. If you prefer not to hear key clicks, the volume can be turned off. The
character repeat capability determines whether or not a key repeats its
action for as long as it is pressed.

The Mouse control is used to select the following:

• Order of button settings

Sets the behavior of mouse buttons 1 and 3. By default, the mouse is set
up for persons who use their right hand. The actions of mouse buttons 1
and 3 can be reversed for persons who are left handed.

• Double-click speed

Sets the maximum interval that can pass between the first and second
click of the mouse to signal a double-click action.

• Pointer acceleration

Sets the speed with which the pointer moves across the display.

• Pointer threshold

Sets the distance in pixels that the pointer moves at a slow speed before
accelerating.

The Beep control is used to set how audible a beep is, the pitch of the beep,
and the duration. The volume can be turned off, which cancels the beep.

______________________ Note _______________________

Not all keyboards let you change the key click volume or the beep
(bell) volume, tone, or duration.

The Screen control specifies whether or not a screen saver is placed on the
screen after a certain time interval. You can choose to have a blank screen
or you can select from the list of screen savers available. By using the
Screen control, you also can specify whether the screen is locked in these
time intervals.
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The Window control alters characteristics such as how the window acquires
focus, if a window raises when it receives focus, and whether or not to use
icon boxes.

4.3.3 Specifying Startup and Logout Behavior

The Style Manager provides a Startup control that you can use to:

• Specify whether you want to resume your current session or start a home
session

• Specify whether or not a logout confirmation is displayed

The session in which you are working is referred to as your current session.
By default, the desktop saves your current session when you log out. This
session is resumed when you log into your next session. By using the Startup
control, you have a choice of returning to the current session or starting a
home session. A home session displays the same settings each time you log
into the system. That is, a home session remains the same regardless of
what you do in the current session.

A logout confirmation queries you before ending a session. You optionally
can specify whether or not you want a confirmation message to appear.
If you set the logout confirmation to Off, you are not given the option of
canceling the logout process. By default, you are prompted to end a session.

Managing the Desktop and Applications 4–9





5
Using Integrated Applications

Several desktop applications and a suite of system management (SysMan)
applications are integrated into the Common Desktop Environment (CDE).
Most of these applications can be started from the Application Manager.

This chapter provides the following information:

• How to start applications

• How to run applications across your network

• An introduction to desktop applications

• An overview of system management applications

• How to use the SysMan Menu

• How to access the SysMan Station

5.1 Starting Applications

You can start many desktop and SysMan applications from either the
Application Manager or from the command line. Use one of the following
methods to start applications:

• To start an integrated application from the Application Manager:

1. Click the Application Manager icon on the Front Panel.

2. Double click the application group you want to access.

3. Double click on the application that you want to start.

• To start an application from the command line, enter the command
name. If the command location is not included in your $PATH variable,
you must include the command’s full pathname. For example, to start
the Image Viewer application from the command line, you could type
the following:

$ /usr/bin/X11/dximageview &

The ampersand (&) at the end of the command line runs the application
in the background, letting you use the same terminal window to perform
other tasks.
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Section 1.3.4.1 tells you how to find reference pages for commands and
applications. The reference page tells you what command invokes the
application, explains options, and provides the location of the command.

Other system management applications can be started from the SysMan
Menu or the SysMan Station.

• Section 5.5 explains how to use the SysMan Menu to get system
management data and run selected system administration tasks.

• Section 5.6 introduces the SysMan Station, a tool to help your system
administrator manage either single systems and clusters.

5.2 Running Applications Across the Network
To run an application that is not installed on your system, you need
network access and an account on a remote system where that application
is installed. You can run the remote application and display the output on
your system as though the application was running locally. Before you can
do this, you must do the following:

• Authorize remote access to your system

• Enable your display on the remote system
You can use the Host Manager to display remotely run applications. See the
Host Manager online help volume for more information.

5.2.1 Authorizing Access to your System

To display remotely run applications on your local system, use the xhost
command to provide the remote host access to your display before you log
into the remote system. For example, if the host name of the remote machine
is trenton, enter the following on your system:

$ /usr/bin/X11/xhost +trenton

The remote system named trenton is added to the list of hosts that
have access to your machine. See the xhost(1X) reference page for more
information.

5.2.2 Enabling the Display

Once you have authorized the remote system access to your local system, log
into the remote system and specify where you want to display the remotely
run application.

The command you enter to enable the display varies depending on the
operating system of the remote host you are using, and the shell you are
using.

Use one of the following methods to enable the display:
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• If the remote host uses the C shell, enter the following at the system
prompt:

setenv DISPLAY local_sysname:0

• If the remote host uses the Bourne or Korn shell, enter the following at
the system prompt:

DISPLAY=local_sysname:0
export DISPLAY

• If the remote host is an OpenVMS system and the OpenVMS network
host is running DECnet, enter the following at the system prompt:

set display/create/node=local_sysname

If the OpenVMS network host is running Transmission Control
Protocol/Internet Protocol (TCP/IP), you can use the TCP/IP network
transport as follows:

set display/create/transport=tcpip/node=local_sysname

If the name of your system appears in lowercase in the OpenVMS
TCP/IP database file, you must enclose the name of your local system
in double quotes ("local_sysname"). If it does not, do not use quotes.
Use the hostname command to see how your system name is entered
into the database file.

In the previous examples, local_sysname is the host name of the machine
where you want the remote application to display.

Once you have authorized access to your system and enabled the display,
you can run the application from the remote machine by using the command
name as described in Section 5.1. The application then displays on the
system you specified.

5.3 Using Desktop Applications
Several desktop applications have been integrated into CDE. Your primary
source of information about any of these applications is each application’s
online help volume. Table 5–1 highlights some of these applications.

______________________ Note _______________________

The desktop applications available on your system may depend
upon the software subsets that you have loaded. This section does
not list all desktop applications available.

Table 5–1 shows some of the desktop applications that are integrated into
CDE.

Using Integrated Applications 5–3



Table 5–1: Desktop Applications
Application Use of Application

DECterm DECterm provides a video terminal emulator.

Differences Provides a graphical display of differences
between two files.

Image Viewer Displays the contents of documents that are in specific
formats such as GIF, JPEG, and TIFF.

Keyboard Options Offers a choice of options that you can use to
customize your keyboard.

Keycaps Shows a graphical display of a keyboard with keycaps
drawn according to the current server keymap and
can be used to start the Keymaps application.

Input Method Options Changes how keystrokes are interpreted by
the operating system.

______________________ Note _______________________

The Input Method Options application is located in /usr/dt/bin
and is not included in the Application Manager under
Desktop_Apps. To start this application, see Section 5.3.4.

Some of the applications described here are advanced tools that address
special needs, and are not intended for everyday use.

5.3.1 Using DECterm

The DECterm application is a video terminal emulator. When DECterm is
started, a window appears on your screen. Enter commands in this window
as you would on any terminal attached to your system or use it for remote
communications to other systems. To start DECterm, enter the following
on your system:

$ /usr/bin/X11/dxterm

Figure 5–1 shows the DECterm application.
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Figure 5–1: DECterm Application

5.3.1.1 Summary of Other DECterm Features

DECterm also lets you:

• Change the appearance of the DECterm window, for example, font size
and window title

• Change the DECterm display features such as the type of cursor and the
use of horizontal and vertical scroll bars

• Change DECterm general features like terminal type

• Compose characters

• Choose a National Replacement Character Set (NRCS)

• Change keyboard, graphic, and printer options
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For more information on using the DECterm application, see the dxterm(1X)
reference page and the online help volume. To access the online help volume,
start DECterm, then select Help.

5.3.2 Using Visual Differences

Visual Differences is a graphical interface to the diff command. By using
Visual Differences, you can compare two ASCII text files line by line, and
then browse through a graphical display of these differences. Figure 5–2
shows the Visual Differences application.

Figure 5–2: Visual Differences Application

For information on using the Differences application, see the dxdiff(1X)
reference page and the online help volume. To access the online help volume,
start Differences, then select Help.
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5.3.3 Using Image Viewer

The Image Viewer application can be used to view graphic files. The
supported image types are GIF, JPEG, TIFF, and XPM. In the Image Viewer
window, you can display images and manipulate the image views using either
the toolbar icons or menus. Figure 5–3 shows the Image Viewer application.

Figure 5–3: Image Viewer Application

For information on using the Image Viewer application, see the
dximageview(1X) reference page and the online help volume. To access the
online help volume, start Image Viewer, then select Help.

5.3.4 Using Input Method Options

The Input Method Options application is a tool for advanced users. You
can use this application to specify an input method and to change how
keystroke characters are interpreted by the system. For example, Asian
(multibyte) characters such as Japanese Kanji or Chinese Hanzi characters
can be entered from the keyboard by using this application. To start this
application, follow these steps:

1. Open a terminal emulator window.

2. Enter the following:

% /usr/dt/bin/dtimsstart

Figure 5–4 shows the Input Method Options application.
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Figure 5–4: Input Method Options Application

For information on using the Input Method Options application, see the
dtimsstart(1) reference page and the online help volume. To access the
online help volume, start Input Method Options, then select Help.

5.3.5 Using Keyboard Options

The Keyboard Options application is a tool for advanced users. Use this tool
to customize keyboard settings. This tool is normally used after the initial
setup of your system only to set options that cannot be specified during the
installation. Figure 5–5 shows the Keyboard Options application.
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Figure 5–5: Keyboard Options Application

For information on using the Keyboard Options application, see the
dxkeyboard(1) and the online help volume. To access the online help
volume, start Keyboard Options, then select Help.

5.3.6 Using Keycaps

The Keycaps application is a tool for advanced users. Use this application to
display and edit keyboard mappings.

For information on using the Keycaps application, see the dxkeycaps(1X)
reference page and the online help volume. To access the online help volume,
start Keycaps, then select Help.

5.4 Using System Management Applications

A suite of system management (SysMan) applications provide a graphical
front-end to administrative commands for the person who administers your
system.

Section 5.1 describes how to access and start the SysMan applications. You
must have the appropriate privileges to use most of these applications. For
information on using each application, see that application’s online help
volume. You can access the help volume by opening an application and
clicking on the Help menu.
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The suite of SysMan applications is divided into several categories, shown in
Figure 5–6:

Figure 5–6: SysMan Categories in Application Manager

• Configuration

Use applications in this category to configure a system after installation.
Ordinarily, you will not need to use these applications once your system
is set up.

• Daily Administration

Use applications in this category for frequently performed system
administration tasks.

• Monitoring and Tuning

Use applications in this category to monitor and tune your system after
it is up and running.

• Software Management
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Use applications in this category to install and manage additional
software on your system.

• Storage Management

Use applications in this category to monitor and manage file sytems.

• Tools

Use applications in this category to display a variety of system statistics
with the Display Window application. You can repeatedly display the
same statistics to monitor progress or trends.

• SysMan Menu

The SysMan Menu provides a hierarchical menu of system management
tasks that can be used in several different user environments such as X
Windows, web browsers, or character-based terminal displays. It can be
started from the command line or from the CDE Application Manager.
Authorized users also can invoke the SysMan Menu from the SysMan
Applications Subpanel.

• SysMan Station

The SysMan Station provides a graphical topological representation
of the system and all its components, letting a system administrator
visually select system components and then run SysMan applications
that apply to that component. The system administrator can use the
SysMan Station to manage both single systems and clusters. You must
be logged in as root to access the SysMan Station.

______________________ Note _______________________

The system management applications available on your system
may depend upon the software subsets that you have loaded. This
section does not list all of the system management applications
available.

To find information about the applications in each SysMan application
group, do the following:

1. Click the Help Manager control from the CDE Front Panel.

2. Click System Management.

3. Click Welcome to SysMan.

4. Scroll down, and click on one of the SysMan application groups.

Each SysMan application in the application group is described along with
restrictions, configuration dependencies, and links to additional information
such as the application’s online help volume and reference page. You also
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can access the online help for any application by starting the application
and selecting Help.

The following items, although not SysMan application categories, are also
available from the Application Manager’s System Administration selection.

• System Setup Checklist

This opens the System Setup application, which launches Quick Setup
and Custom Setup. You can use the System Setup Checklist after
installation to configure your system with each of the Configuration
Applications listed. A check mark next to an application icon indicates
that the application has been run. For more information on the System
Setup Checklist, refer to the online help volume and the System
Administration.

• Welcome to SysMan

Select this item for a shortcut to the Welcome to SysMan online help
volume.

5.5 Using SysMan Menu

A system administrator uses the SysMan Menu to view system management
data and run selected system administration tasks. You must have the
appropriate privileges to run some of the tasks on the SysMan Menu.

______________________ Note _______________________

Although many of the system administration tasks on the
SysMan Menu may seem to duplicate those available from the
Application Manager, the SysMan Menu also provides access to
these tasks from the following platforms:

• Any local or remote character-cell terminal

• Any X11–compliant windowing environment, such as CDE
or DECwindows

• Windows 95 or Windows NT running on a personal computer
(PC)

Multiplatform access to the SysMan Menu is described in the
System Administration manual.

If you have the appropriate privileges, you can access the SysMan Menu
in one of the following ways:

• From the command line:

# /usr/sbin/sysman
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The sysman(8) reference page discusses available options, including
GUI and character-cell interfaces.

• From the CDE Front Panel:

– Select the SysMan Menu icon from the Application Manager

– Select the SysMan Menu icon from the SysMan Applications subpanel

To select and run a task from the SysMan Menu, first highlight the item that
you want. Categories and tasks are displayed in the following manner:

• Categories that can be expanded are preceded by a plus (+) character

• Categories that are fully expanded are preceded by a minus (−) character

• Executable tasks are preceded by a pipe (|) character
To expand a category, do one of the following:

• Select an expandable category

• Highlight the category and choose the Select button
Continue to expand subcategories until the task title is displayed. You can
use either selection method to start the actual task.

If you do not know where the task is located in the SysMan Menu hierarchy,
you can do the following:

1. Select Find at the bottom of the SysMan Menu. The Find Task by
Keyword dialog box is displayed.

2. Enter a keyword in the text entry field. Wildcard characters are
permitted, and the search is case sensitive. For example, you could
enter *[Nn]etwork* to locate tasks related to networks.

3. Select the task that you want from the displayed list.

For information on using SysMan Menu, see the sysman(8) reference page,
the System Administration guide, and the online help volume. To access the
online help volume, start SysMan Menu, then select Help.

5.6 Using SysMan Station
A system administrator uses the SysMan Station to manage both single
systems and clusters. You must be logged in as root to see the SysMan
Station icon, which displays on the Front Panel, the SysMan Applications
subpanel, and in the Application Manager’s System Management
Applications group.

The SysMan Station provides a graphical representation of the system and
all its components. It lets you visually select system components and then
run SysMan applications that apply to that component. The SysMan Station
provides a graphical representation of the system hierarchy from the host
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down to individual devices such as disks and tapes. You can select devices
and then apply appropriate device management applications.

For information on using SysMan Station, see the sms(8) reference page, the
System Administration guide, and the online help volume. To access the
online help volume, start SysMan Station, then select Help.
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6
Migrating to CDE

The Common Desktop Environment (CDE), based upon Motif and X11, was
developed by major UNIX vendors to consolidate UNIX desktop interfaces
and define a consistent user and development environment. These vendors
formed the Common Operating System Environment (COSE) consortium.

CDE is built on existing technologies from the COSE founders and from the
Open Software Foundation (OSF). CDE is not a replacement for Motif; it is
another layer on top of Motif combining expanded programming utilities and
a consistent user interface.

Under this version of the operating system, CDE is offered as a successor to
the DECwindows Motif interface. This chapter discusses:

• Common components between CDE and DECwindows Motif

• Differences between CDE and DECwindows Motif

• Where to get more information about using CDE

6.1 Common Features Between CDE and DECwindows
Motif
Both CDE and DECwindows Motif operate under the same premise. Each
is comprised of four components that create your workspace environment.
These include the X server, Window Manager, Session Manager, and client
applications. The following sections highlight these components.

This section contains the following information:

• X Servers and Clients

• Session Manager

• Window Manager

• X Client Applications

6.1.1 X Servers and Clients

Both CDE and DECwindows Motif use the client/server method of
computing. A component called the X server provides display services. The
X server acts as an intermediary between applications and the workstation’s
display hardware. That is, it handles output from the clients to the display
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and forwards input (from the keyboard or mouse) to the appropriate client
for processing. X clients are applications that make use of the services
provided by the X Window System.

X clients can run on your workstation or on another system. Because there
is built-in networking capability, applications can run on one system and
be displayed on another workstation that supports the X Window System
protocol.

6.1.2 Session Manager

In both the CDE and DECwindows Motif interfaces, logging in to the system
starts the Session Manager. The Session Manager is the top level interface
to the operating system. The Session Manager handles the following:

• Sources appropriate files such as startup scripts

• Sets up search paths

• Gathers available applications and starts the session applications

• Starts the Window Manager

The CDE Session Manager that starts upon logging into the
system is /usr/dt/bin/dtlogin, but the control is handed to
/usr/dt/bin/dtsession after the session has started.

In the DECwindows Motif environment, the Session Manager started is
/usr/bin/X11/dxsession.

6.1.3 Window Manager

For both CDE and DECwindows Motif, the Window Manager controls the
appearance of window frame components, behavior of windows including the
stacking order and focus behavior, key and button bindings, appearance of
minimized windows, and behavior of menus.

The CDE Window Manager is often referred to as the Workspace Manager
and is based on the OSF/Motif Window Manager. The default Window
Manager for CDE is /usr/dt/bin/dtwm.

The DECwindows Motif Window Manager is /usr/bin/X11/mwm.

6.1.4 X Client Applications

This operating system includes many sample X client applications supplied
by the X Consortium. Under the operating system, DECwindows Motif
provides a set of desktop applications. Likewise, CDE brings a set of
applications that provides several features not available in the DECwindows
Motif interface.
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Section 7.2 provides more information on using applications in the CDE
interface.

6.2 Differences Between CDE and DECwindows Motif

Although CDE and DECwindows Motif consist of similar components, CDE
offers many features not available in DECwindows Motif. The remaining
chapters in this manual discuss how to manage your session using CDE
as opposed to using the DECwindows Motif Session Manager menu. The
following list highlights what is discussed in these chapters:

• Chapter 7 discusses differences in starting and ending a session and
describes how to access applications using CDE.

• Chapter 8 discusses differences in customizing your environment by
highlighting how to complete these actions using CDE as opposed to
DECwindows Motif.

• Chapter 9 discusses internationalization issues such as selecting a
language type, specifying keyboard types, and differences in the terminal
emulator.

• Chapter 10 discusses how to migrate mail folders and calendar databases
to a format that is understood by the CDE Mailer and CDE Calendar
applications respectively.

• Appendix A discusses differences between the CDE Mail and
DECwindows Mail applications.

6.3 Obtaining More Information

The CDE documentation set is available on line and in hardcopy. To view
the CDE documentation set on line, you must use the Netscape Viewer. You
can also obtain information about CDE by accessing the online help volumes
and reference pages.

Section 1.3 tells you how to view the CDE documentation set on line and
provides information about accessing online help and reference pages.

Migrating to CDE 6–3





7
Using a New Session Manager

Differences exist between managing a Common Desktop Environment (CDE)
session and managing a DECwindows Motif session. This chapter introduces
methods you can use to manage your environment and access applications,
and addresses differences between CDE and DECwindows Motif.

By using CDE, you benefit from an environment that offers the same
features found in DECwindows Motif and more. The following sections
describe the major features of starting and ending a CDE session, and
provides information on managing your environment as you did using the
DECwindows Motif Session Manager.

This chapter contains the following information:

• Starting and Exiting a Session

• Accessing Applications

7.1 Starting and Exiting a Session

The CDE Login Screen provides a set of options that were not available
through the DECwindows Motif Login Screen. From the CDE Login Screen,
you can select a session type and a language type.

There are three types of sessions that you can select:

• A Regular Desktop Session starts the CDE Session Manager. This is
the default session.

• A Failsafe Session starts a single terminal window and the Window
Manager.

• A Command-Line Session suspends the desktop and provides a way for
you to work in the base operating system environment.

The default language is set by your system administrator; however, by using
the Options menu from the login screen you can also access other languages
that are installed on your system. The default language is restored when
you end your session.

______________________ Note _______________________

CDE ignores any xnlLanguage settings in your .Xdefaults
file. This variable typically is set in an earlier DECwindows
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session, where you made a selection from the session manager’s
language menu and saved that setting. CDE ignores this to
prevent overriding any language that you select in the Options
menu from the login screen.

By default, CDE provides automatic save and restore of your session. All
applications that are opened when you exit a session, which support save
and restore, are opened when you log in again. For some applications, all the
work from the previous session is restored, while for others only the main
screen of the application is restored.

For information on customizing the start and end of a session as you were
able to do using the DECwindows Motif Session Manager, see Section 8.1.

______________________ Note _______________________

The remaining chapters in this manual discuss a Regular
Desktop session only. See the Common Desktop Environment:
User’s Guide for detailed information on starting a Failsafe or
Command-Line session.

7.2 Accessing Applications

From the CDE Front Panel, you can start several applications. Most of these
applications are equivalent to those found in the DECwindows Motif Session
Manager Application menu (see Table 7–2) and can be started from the
Front Panel, Application Manager, File Manager, and of course, a terminal
emulator window.

The Front Panel is the narrow window at the bottom of your screen. It
contains a set of applications and controls, which can be compared to the
DECwindows Motif Session Manager menu as it provides a similar set of
services. That is, you can start an application by clicking on its icon, pause
a session by clicking on the Lock icon, or exit a session by clicking on the
Exit icon. Section 7.2.1 describes all of the applications and controls located
on the Front Panel.

The icon-based File Manager, available from the Front Panel, provides a
view and easy navigation of a directory hierarchy. When used with drag and
drop actions, you can manipulate directories and files and interact with
other applications. You can also launch applications using the File Manager.

The Application Manager, available from the Front Panel, is a special
directory for applications and other tools on your system. Using the
Application Manager, you can launch applications, add other applications to
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the Application Manager, or place an application on the backdrop or on the
Front Panel for easier access.

This chapter contains the following information:

• Managing Applications from the Front Panel.

• Starting Applications from the Application Manager.

• Running Applications with the File Manager.

• Using DECwindows Motif Applications.

7.2.1 Managing Applications from the Front Panel

In addition to the Application Manager and the File Manager, the
Front Panel employs some other concepts that are not available in the
DECwindows Motif environment. This includes the use of subpanels and
workspaces.

Any Front Panel icon that has an arrow above it indicates that a subpanel
is available. A subpanel contains a menu of applications and controls that
you can use further to manage your desktop session. Click on any arrow
to display a subpanel menu.

A workspace is the screen display area, which includes the Front Panel.
Using the Workspace Switch (buttons numbered one through four) on the
Front Panel, you can set up and move between multiple work areas in the
same session. Each workspace includes the Front Panel. You can have up to
64 workspaces. Click on any workspace button to change workspaces.

To start an application from the Front Panel, click on the application icon.
To start an application from a subpanel:

• Click on the subpanel arrow to display a list of options

• Click on the application icon

7.2.1.1 Adding an Application to a Subpanel

Any application icon that resides in the File Manager or Application
Manager can be added to a subpanel. To add an application to a subpanel:

1. Open the File Manager or Application Manager and display the
application icon you want to add.

2. Open the subpanel where the application icon is to be added.

3. Drag the icon from the File Manager or Application Manager and drop
it on the subpanel’s Install Icon.

Any application icon that is added to a subpanel displays the same behavior
as when it resided in the File Manager or Application Manager.
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7.2.1.2 Adding a Subpanel Control to the Front Panel

You can add a copy of a subpanel control to the Front Panel for easier access.
To copy a subpanel control to the Front Panel:

1. Open the subpanel that contains the application icon you want to copy.

2. Point to the application icon you want to add and click on mouse button 3
to display its pop-up menu.

3. Choose Copy to Main Panel from the pop-up menu.

7.2.1.3 Replacing a Control in the Front Panel

To replace a control in the Front Panel easily, exchange it with a subpanel
control.

1. Open the subpanel of the control you want to replace. If the control does
not have a subpanel control, you can create it:

a. Point to the control in the Front Panel and click on mouse button 3.

b. Select Add Subpanel from the pop-up menu.

c. Display the new subpanel.

d. Add the control you want to place on the Front Panel to the
subpanel as described in Section 7.2.1.2.

2. Point to the control in the subpanel and click on mouse button 3 to
display the pop-up menu.

3. Choose Copy to Main Panel from the pop-up menu.

If you had to create a subpanel and you do not want to retain it, point to the
Front Panel control icon and click on mouse button 3. You can then select
the Remove Subpanel option.

If you are an advanced user, you can also create or edit a Front Panel
configuration file that changes the characteristics of the Front Panel.
See the Common Desktop Environment: Advanced User’s and System
Administrator’s Guide for more information.

7.2.1.4 Removing Front Panel Customizations

You can remove Front Panel customizations made by using the Install Icon
control or using the Front Panel pop-up menus:

1. Open the Application Manager.

2. Double click on the Desktop_Tools application group.

3. Double click on Restore Front Panel.

7–4 Using a New Session Manager



This procedure does not affect customizations made using Front Panel
configuration files.

7.2.2 Starting Applications from the Application Manager

The Application Manager contains a set of built-in application groups. Each
application group is a directory that contains one or more icons that you can
use to open applications. An icon group can also contain other application
files such as data files, templates, and “read me” files. Table 7–1 shows the
default built-in application groups in the Application Manager.

Table 7–1: Built-In Application Groups
Group Description

Conversion_Tools Contains applications to migrate the DECwindows Calendar
to the CDE Calendar, and to convert mail folders from
dxmail format to CDE’s dtmail format.

Desktop_Apps Contains the desktop applications such as the File Manager,
Style Manager, and Calendar applications.

Desktop_Tools Contains commonly used tools for the desktop administration such
as the vi Text Editor, Check Spelling, and Reload Application.

Information Contains frequently used help volumes.

System_Admin Contains the tools used by the system administra-
tor to manage the system.

You can have additional application groups. The previous table lists those
known groups available by default.

To start an application from the Application Manager:

1. Double click on the application group where the application is located.

2. Double click on the application.

You can also create personal application groups as described in the Common
Desktop Environment: User’s Guide.

7.2.3 Running Applications with the File Manager

The File Manager is predominately used to create, find, and manage desktop
objects such as files, folders, and applications. If an application uses data
files, you also can start an application from the File Manager using the
application’s data file.

Use one of the following methods to start an application using its data file:

• Double click on the application’s data file. For example, double clicking
on a bitmap file (*.bm) starts the Icon Editor application.
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• Point to an application’s data file, click on mouse button 3 and then
choose Open from the pop-up menu.

You can also use the drag and drop features with the File Manager to
interact with applications. For example, drag a file from the File Manager
and drop it on the Print Manager to print a file or drag a help volume with
an .sdl extension and drop it onto the Help Manager to open a help volume.

7.2.4 Using DECwindows Motif Applications

Most of the applications available with the previous version of DECwindows
Motif have equivalents available in CDE. Those that do not have equivalents
in CDE have been integrated into the desktop and are available through the
Application Manager.

Table 7–2 lists the DECwindows Motif applications, followed by the
recommended application to use, its executable name, and its location.
DECwindows Motif applications that are not integrated into CDE are still
available in /usr/bin/X11.

Table 7–2: Recommended Applications to Use in CDE

DECwindows
Application
Name

Recommended Application
Name Executable Location

Bookreader Netscape Browsera netscape Front Panel
(Personal
Applications
subpanel)

CDE HelpViewera dthelpview Front Panel
(Help Manager)

Calculator CDE Calculator dtcalc Front Panel

Calendar CDE Calendarb dtcm Front Panel

Image Viewer Image Viewerc dximageview Application
Manager

Clock CDE Clockd Front Panel

DECterm CDE Terminal dtterm Front Panele

Differences Differencesf dxdiff Application
Manager

Mail CDE Mailerb dtmail Front Panel

Notepad CDE Text Editor dtpad Front Panel
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Table 7–2: Recommended Applications to Use in CDE (cont.)

DECwindows
Application
Name

Recommended Application
Name Executable Location

Paint CDE Icon Editor dticon Front Panel
(Personal
Applications
subpanel)

a See Section 1.3 for information on the documentation set and online help.
b Migration tools are available that you can use to convert your DECwindows Motif mail folders and calendar
database to a format that can be understood by the CDE mail and calendar applications. See Chapter 10 for
information on using these converters.
c Image Viewer (dximageview) is recommended. A desktop application, it has been integrated into CDE, it is
available from the Application Manager. See Section 5.3.3 for more information.
d CDE Clock is an indicator only; it does not perform actions. To set an alarm, use the CDE Calendar
application.
e Starting the CDE Terminal from the Front Panel consumes considerable system resources. If you are
opening several terminal emulator windows, start a new terminal emulator from an existing terminal
emulator window. To do this, select the Window menu, then choose the New option.
f The application Differences is a desktop application that is integrated into CDE. See Section 5.3.2 for
more information.

The following DECwindows applications have been retired from this
version of the operating system. The replacement applications are listed
in Table 7–3.

Table 7–3: Retired DECwindows Applications
Retired DECWindows Applications Replacement Applications

dxprint dtlp

dxcalendar dtcm

dxcalc dtcalc, xcalc

dxclock Front Panel, xclock

dxpaint dticon/dtstyle, bitmap

dxnotepad dtpad

dxbook dthelpview, Netscape

dxcardfiler N/A

dxsession xdm, dtsession

dxvdoc ghostview

dxmail dtmail, xmh, exmh, Netscape mail
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8
Customizing Your Environment

You cannot migrate to a new user interface without expecting changes.
The Common Desktop Environment (CDE) offers you tools and methods to
customize your environment that differ from those used in the DECwindows
Motif environment. This chapter briefly describes how to customize your
session.

This chapter contains the following information:

• Customizing Your Startup Environment

• Changing Session Manager Settings

• Customizing Window Patterns and Colors

• Changing Your Security Settings

• Customizing the Keyboard Settings

• Specifying a Session Language

• Customizing Mouse and Pointer Behavior

• Saving and Restoring Settings

• Modifying Resource Files

8.1 Customizing Your Startup Environment

Using CDE, you can add frequently used applications to the Front Panel and
subpanels. See Section 7.2.1 for information on adding applications to the
Front Panel and subpanels. The applications that are started automatically
at startup are determined by the options you set when using the Style
Manager Startup control.

When you click on the Style Manager Startup control, a dialog box appears.
You have the option at login to resume your current session, return to your
home session or ask me at logout the next time you log out:

• Resuming the current session restores your session to the state present
at logout.

• Resuming a home session returns to the same state each time. That is,
any settings you specified during your current session are ignored.

Customizing Your Environment 8–1



• When you select ask me at logout, the startup session uses a specific set
of session resources when you are using a particular display, such as
logging in from a remote workstation. To set up a display-specific session:

1. Create a $HOME/.dt/display directory, where display is a real
unqualified hostname such as host:0. Using host.site.com:0 is
not valid.

2. Copy the entire contents of the $HOME/.dt/sessions directory
to the new $HOME/.dt/display directory. Include all files and
subdirectories.

The session resources in the $HOME/.dt/display directory are used
when you log in with $DISPLAY set to display, for example, host:0.

See the Common Desktop Environment: User’s Guide for information on
adding applications and setting a login session. See the Common Desktop
Environment: Advanced User’s and System Administrator’s Guide for
information on setting a display-specific session.

8.2 Changing Session Manager Settings

When using CDE, the Front Panel always is displayed unless you start a
Failsafe Session, or a Command-Line Login session. To turn the Front Panel
into an icon after logging into the system, use the window or menu controls.

To turn Logout Confirmation on or off, use the Style Manager Startup
control.

You cannot change the Lock (Pause) screen message as you could with
DECwindows Motif.

8.3 Customizing Window Patterns and Colors

This section describes how you can do the following:

• Choose a different window manager

• Specify a screen saver

• Change background patterns

• Select solid foreground and background

• Choose window foreground, background, highlight and border colors

Changing these options when using CDE differs. The following sections
discuss how to change the window manager, specify a screen saver and lock
background, select a background pattern, and how to change colors.
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8.3.1 Changing the Window Manager

When you start a CDE session, the default window manager,
/usr/dt/bin/dtwm is started. Unlike the DECwindows Motif environment,
specifying an alternate window manager is an advanced feature. You edit
resource files to change the Window Manager in CDE. See the Common
Desktop Environment: Advanced User’s and System Administrator’s Guide
for further information.

8.3.2 Specifying a Screen Saver and Lock Screen Background

A screen saver extends the life of your monitor by blanking the screen after a
specified amount of time. By default, the monitor blanks the display after
10 minutes. Moving the mouse causes the display to resume. A screen lock
background is displayed when you pause a session from the CDE Front
Panel.

You can customize what is displayed by using the Style Manager Screen
control. Refer to Section 4.3.2.

8.3.3 Selecting a Background Pattern

In CDE, you can specify a background pattern for each of your workspaces
using the Style Manager Backdrop control. The Backdrop control opens
a dialog box, which offers a scrollable lists of background selections. You
can also display the root window by selecting No Backdrop from the list of
options.

8.3.4 Changing Screen and Window Colors

When using the CDE Style Manager, colors are set by using the Style
Manager Color control. The Color control sets screen, window, workspace,
and Front Panel colors according to your display type. Depending on your
display type, you may have 2, 4, or 8 color buttons that you can use to control
the color of windows, window borders, workspaces, text and list areas, and
Front Panel background. See the Common Desktop Environment: User’s
Guide for information on color controls and selecting color palettes.

8.4 Changing Your Security Settings

To change your security settings, use the Host Manager application or the
xhost command. The Host Manager displays icons for all hosts known
to the local system and for those hosts that you specify. By using the
Host Manager, you can set the DISPLAY environment variable and run
applications from a remote system.
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To start the Host Manager from the Application Manager:

1. Double click on System_Admin.

2. Double click on DailyAdmin.

3. Double click on the Host Manager application.

See the Host Manager online help for more information. To view the online
help, click on the Help menu from within the application.

For information about the xhost command, see the xhost(1X) reference
page.

8.5 Customizing the Keyboard Settings
When using CDE, keyboard settings can be changed by using the Style
Manager controls and the Keyboard Options application. The following
sections discuss these methods.

This section contains the following information:

• Using Style Manager to Adjust Keyboard Settings

• Using Keyboard Options to Adjust Keyboard Settings

• Changing PC-Style Keyboards

8.5.1 Using Style Manager to Adjust Keyboard Settings

By using the Style Manager controls, the following keyboard settings can
be adjusted:

• Beep (Bell) Volume

Sets the volume, tone and duration of the warning beep (bell) or turns
the beep off. The warning beep notifies you of system messages, or warns
you when you type incorrect key combinations in applications such as
the vi text editor.

• Keyclick Volume and Auto Repeat

Sets the click volume of keys as you type or turns off the click volume.
You can also set whether or not a key repeats for as long as it is pressed.
To adjust the click volumes of keys and to turn auto repeat on or off, use
the Style Manager Keyboard control. A dialog box appears that you can
use to change the keyclick volume and auto repeat of keys.

______________________ Note _______________________

Not all keyboards let you change the key click volume or the beep
(bell) volume, tone, or duration.
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8.5.2 Using Keyboard Options to Adjust Keyboard Settings

The Keyboards Options application has been migrated and integrated into
the CDE interface. It offers further options that you can use to control
keyboard settings. Use this application to set the following:

• Keyboard Type

• Language Type

• Lock Key State

By using the Keyboard Options application, you can also start the
Keycaps application and save and load settings for future sessions. For
more information on the Keyboard Options and Keycaps applications, see
Chapter 5.

8.5.3 Changing PC-Style Keyboards

Several workstations come with personal computer (PC)-style keyboards.
Currently, these keyboards have one of the following model numbers,
although more models may be produced in the future:

• PCXAL

• LK443

• LK444

Other workstations come with keyboards such as the LK201 or LK401.

The two styles of keyboards differ both in the functions assigned to certain
keys and in the number of function keys. For example, the PC-style
keyboards have only 12 function keys (F1 through F12); the LK201/LK401
keyboards have 20 function keys (F1 through F14, Help, Do, and F17 through
F20).

This operating system provides a script that automatically performs
mappings to allow you to switch keyboard styles. This script,
/usr/examples/pc_to_lk_keys.sh, uses the xmodmap utility to edit the
keyboard modifier map and keysym table. (For details about the utility,
see the xmodmap(1X) reference page.)

If you have a PC-style keyboard, you can run the script to map most of
the keys on the two keypads to the right of the main keyboard, as well as
a few keys in the top function key row, to the corresponding keys on the
LK201/LK401 keyboards. For example, by running the script, you change
the function of the keypad Insert key on the PC-style keyboard to perform
the keypad Find function from the LK201/LK401 keyboards.
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Similarly, if you have an LK201/LK401 style keyboard, you can run the
same script, this time with the -u flag, to map the keypad keys to the
corresponding PC-style keys.

A copy of the script is located in the following file on your system:

/usr/examples/pc_to_lk_keys.sh

To run the script, at the system prompt enter the name of the file as if you
were entering a command. The first command line in the following example
changes PC-style keys to LK201/LK401 keys. The second command line
changes LK201/LK401 keys to PC-style keys.

% /usr/examples/pc_to_lk_keys.sh
% /usr/examples/pc_to_lk_keys.sh -u

To have the script run automatically each time you log on to your
workstation, use an editor to create or modify the .xsession file in your
home directory to read as follows:

#!/bin/sh
/usr/examples/pc_to_lk_keys.sh
dxsession

This changes PC-style keys to LK201/LK401 keys. The same .xsession file,
but with -u flag added to the end of the second line, changes LK201/LK401
keys to PC-style keys.

Now, whenever you log in, your keyboard is set automatically to the different
keyboard style.

Table 8–1 shows the keys on the LK201/LK401 keyboard and their
corresponding equivalents on the PC-style keyboard.

Table 8–1: LK201/LK401 Key Functions and Their PC-Style Equivalents
Key on the LK201/LK401 Keyboards Equivalent Key or Function on a

PC-Style Keyboard

Help Print Screen

Do/Menu Scroll Lock

Insert Home

Find Insert

Remove Page Up

Next Page Down

Select Delete

Prev End

Keypad 0 Ins, Keypad 0
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Table 8–1: LK201/LK401 Key Functions and Their PC-Style Equivalents
(cont.)

Key on the LK201/LK401 Keyboards Equivalent Key or Function on a
PC-Style Keyboard

Keypad 1 End, Keypad 1

Keypad 2 Down arrow, Keypad 2

Keypad 3 PgDn, Keypad 3

Keypad 4 Left arrow, Keypad 4

Keypad 5 Keypad 5

Keypad 6 Right arrow, Keypad 6

Keypad 7 Home, Keypad 7

Keypad 8 Up arrow, Keypad 8

Keypad 9 PgUp, Keypad 9

Keypad . (period) Keypad Del

Keypad - Keypad + (addition)

Keypad , No equivalent PC-style keypad key

Keypad Enter Keypad Enter

PF1 Num Lock

PF2 Keypad / (division)

PF3 Keypad * (multiplication)

PF4 Keypad – (subtraction)

______________________ Note _______________________

The PC-style keyboard has a key labeled ← in the position where
the key marked is located on the LK201/LK401 keyboard.
On both styles of keyboard, this key deletes the character to the
left of the cursor when pressed. On the PC-style keyboard, you
can use the Delete key on the near keypad to delete either the
character that the block cursor is on or the character to the left
of the line cursor. In keyboard mappings, the ← and keys
perform the backspace function. The Delete key on the PC-style
keyboards performs the delete function.
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8.6 Specifying a Session Language
By using CDE, you can specify a language type each time you log into the
system. You cannot change the language during the session.

The default language is set by your system administrator. To set the session
language from the login screen, click on the Options menu, then click on the
Language menu item and select a language group. You can select from a list
of languages that have been installed on your system. The default language
is restored when you end your session.

______________________ Note _______________________

CDE ignores any xnlLanguage settings in your .Xdefaults
file. CDE ignores this to prevent overriding any language that
you select in the Options menu from the login screen.

8.7 Customizing Mouse and Pointer Behavior
When using CDE, mouse and pointer behavior is adjusted by using the Style
Manager Mouse control. CDE offers some adjustments not available in the
DECwindows Motif environment; however when using CDE, you cannot
adjust the color or shape of the pointer.

Use the Mouse control to adjust the following:

• Handedness (Button Arrangement)

Specifies how mouse buttons are to be interpreted. By default, mouse
buttons are arranged for use by a right-handed person. That is, mouse
button 1 is on the left and mouse button 3 is on the right. You can specify
that mouse button 1 be the left-most button and mouse button 3 be the
right-most button for a left-handed person.

• Button 2

Specifies the behavior of mouse button 2. Mouse button 2 can be set
to Transfer or Adjust mode. When using the Transfer setting, mouse
button 2 is used to drag and drop list or text items (if supported by the
application).

When using the Adjust setting, mouse button 2 extends lists selections
in a multiple-select list or extends text selection fields; list items are
dragged and dropped by using mouse button 1.

• Pointer Acceleration

Provides a slider that you can use to vary how fast the pointer moves
across the screen. For example, a setting of 2 causes the pointer to move
twice as fast as the mouse moves.
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• Mouse Double Click Timeout

Specifies how the system interprets two successive clicks of the mouse.
That is, it sets the time in which you must click a mouse twice to signal a
double click action. For example, double clicking on certain icons starts
an application.

• Mouse and Pointer Threshold

Specifies the minimum number of pixels you must move the mouse
before the pointer moves at the specified accelerated speed.

8.8 Saving and Restoring Settings

Any changes that you make during a session can be saved. When you change
options or settings using the Style Manager, each control provides a dialog
box that you can use to OK or Apply changes. Using the CDE Style Manager
Startup control gives you the opportunity to specify whether these are the
settings you return to in your next session.

The CDE Style Manager Startup control specifies whether you return to
your current session, home session, or a display-specific session.

8.9 Modifying Resource Files

The Common Desktop Environment: Advanced User’s and System
Administrator’s Guide describes the resource files you can modify to change
your environment. This section briefly highlights those files you edited
previously under DECwindows Motif and explains whether or not they
remain applicable:

• The .xsession file is still valid in the new environment.

• The .Xdefaults file can still be used; however, automatic startup of
applications is not valid.

• The .mwmrc file has been replaced by the $HOME/.dt/dtwmrc file.

• The .X11start file has been replaced by the $HOME/.dt/ses-
sion/sessionetc file.

Under DECwindows Motif, the system administrator often edited
files in /usr/lib/X11/xdm. Equivalents in CDE can be found in
/usr/dt/config. These files include Xaccess, Xservers, Xsession and
Xsetup/Xsetup -0.
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9
Using Internationalization Features

This chapter provides information on using internationalization features.
Migrating to the Common Desktop Environment (CDE) affects those who
used internationalization features in the DECwindows Motif environment.
Differences exist in the following:

• Selecting language types

• Specifying a keyboard type, loading keymaps, and selecting input
methods

• Using the terminal emulator

• Using mail

The following sections explain these differences and provide information on
how to accomplish the same tasks using CDE:

9.1 Selecting a Language Type

In the CDE environment, you change the language type at any time using
the Option menu. The default language is set by your system administrator;
however, you can select a language at the start of a session or set resources
in CDE’s Xconfig file. The language that you select cannot be modified
during the session. Information on setting a language from the login screen
is documented in Section 2.3.1.

______________________ Note _______________________

CDE ignores any xnlLanguage settings in your .Xdefaults
file. CDE ignores this to prevent overriding any language that
you select in the Options menu from the login screen.

To set the default session by editing the Xconfig resource file:

1. Create the directory /etc/dt/config if it does not exist. You must
have root privileges to create this directory.

2. Copy the file /usr/dt/config/Xconfig to the directory you created
in Step 1.
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3. Edit the file /etc/dt/config/Xconfig and add the language you
want to use as your default. For example, if you want to use Japanese,
add the following line:

defaultLanguage: ja_JP.eucJP

If you do not want to use this language during each session, you can override
it by selecting another from the CDE Login Screen Options menu.

No matter which method you use to select a language, each application you
start after logging into the system is displayed in the language selected.

9.2 Specifying a Keyboard Type, Keyboard Attributes and
Input Methods
When using CDE, you must use the Keycaps, Keyboard Options, and Input
Methods applications to change these characteristics.

The Keyboard Options application is used to select a localized keymap and to
set the lock key state. From this application, you can also start the Keycaps
application, which is used to change keycaps mappings. See Section 5.3.5 for
information on using this application.

The Keycaps application is used to select a keyboard type, simulate key
events, and to display and edit keyboard mappings. To use the Keycaps
application, see Section 5.3.6.

The Input Methods application is used to change how keystroke characters
are interpreted by the system. For example, Asian (multibyte) characters
such as Japanese Kanji or Chinese Hanzi characters can be entered from the
keyboard using this application. See Section 5.3.4 for more information on
this application.

______________________ Note _______________________

For Asian Languages, the CDE Session Manager automatically
starts the appropriate input method server when you log into
the system. To disable this feature, edit your .dtprofile file
and set DTSTARTIMS to False.

9.3 Using the Terminal Emulator

The default terminal emulator in the CDE interface is dtterm. The dtterm
terminal emulator does not have the following features:

• Bidirectional support (needed for Hebrew language support)

• Zero-width character support (needed for Thai language support)
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• Ruled-line support (needed for Japanese language support)

Because these features are not supported, using the DECwindows Motif
terminal emulator, dxterm, is recommended where such support is needed.
You can access dxterm from the Application Manager. In certain locales,
dxterm is available from the Text Editor Personal Applications subpanel.
You can also start the dxterm terminal emulator from a dtterm terminal
emulator window or add it to the Front Panel or a subpanel as described
in Section 7.2.1.

See the Common Desktop Environment: User’s Guide for instructions on
using the dxterm terminal emulator.

9.4 Using Mail

When using the CDE mail application, dtmail, you do not have to turn
on codeset conversion support. It is turned on automatically through the
/usr/dt/config/svc/OSF1.lcx configuration file, which contains the
needed information.
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10
Migrating Mail and Calendar

This chapter provides information on how to migrate mail and calendar to
CDE. Many people have mail folders and calendar databases that they want
to continue to use in their new environment. Changing to a new application
often means losing this information. To ease the complexity of migrating, you
can use the tools described in this chapter to convert your existing dxmail
and dxcalendar folders and databases into a format that is understood by
the CDE mail and calendar applications.

The Common Desktop Environment: User’s Guide provides details on using
the CDE Mail and Calendar applications. See Appendix A for information on
the differences between the MH/dxmail and dtmail mail handlers.

This chapter describes how you can do the following:

• Convert Mail Formats

• Convert Calendar Databases

10.1 Converting Mail Formats

The CDE mail application is completely integrated with the environment and
thus offers more flexibility than continuing to use the dxmail application.
For example, files can be dragged from other CDE applications and dropped
onto the mail application for further action.

The CDE mail application also supports Multimedia Internet Messages
Extension (MIME). Support for MIME lets you send and receive mail
messages in formats other than ASCII text. For example, you can send and
receive messages that are in video format.

Before you convert your mail formats to a format that can be read by the
CDE mail application, you should understand how mail is stored by both
applications. You can then convert your mail from the dxmail format to the
dtmail format by using the mailcv utility or the CDE File Manager.

This section provides information on the following:

• Understanding How Mail Is Stored

• Converting Mail Using the Mail Conversion Utility

• Converting Mail Using the File Manager
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10.1.1 Understanding How Mail Is Stored

The dxmail and dtmail applications store information differently. For this
reason, you must convert your dxmail folders to a format that can be read
by the dtmail application.

10.1.1.1 Storing MH/dxmail

To store mail, the MH/dxmail application creates a mail hierarchy with
a top level directory. The location of this directory is defined in your
$HOME/.mh-profile. This profile not only specifies the location of your top
level directory, it also includes other information about the setup of your
mail. Usually, the path for the top level directory is set to $HOME/Mail.
If you changed this path, you can verify its location by using the mhpath
command with the + flag. You need to know the location of your top level
directory to convert mail folders.

______________________ Note _______________________

To use the mhpath command, the MH subsets must be installed
on your system.

Under your top level directory Mail, you may have several other directories
(folders) or files. Messages are stored in folders numerically and in
sequential order. Each message corresponds to an individual file as follows:

Mail

/inbox /drafts /meetings /personal

1,2,3 1,2 /group /unit 1,2,3 /gardening

1,2,3 1,2,3 1,2,3

In the previous example, there are four folders directly under the top level
directory Mail. Individual messages are stored numerically. For example,
under the folder Inbox, there are three files that contain individual
mail messages. They are numbered 1, 2, and 3. Some directories have
subdirectories such as meetings, which includes subdirectories for group
and unit. Mail messages are further grouped under these directories
numerically.

10.1.1.2 Storing CDE Mail

The CDE mail application dtmail has no set structure for how messages are
stored. You can create mail folders in any directory that you can access, and
you can store more than one message in a mail folder using the UNIX “From”
format. Mail messages stored in the same mail folder are concatenated with
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each message separated by a UNIX “From” header. Mail utilities such as
mailx use this format and can also read these messages. The following is
a sample mail hierarchy that can be created with the dtmail application.
In this example, messages are stored into mail folders that have a .mbe
extension.

MailBox

inbox.mbe drafts.mbe /meetings /status

/group /unit jan.mbe feb.mbe

wkly.mbe mthly.mbe

In the previous example, the top level directory, MailBox, is displayed.
Under this top level, there are both directories and mail folders. The mail
folders can contain one or more mail messages. A mail directory can contain
both mail folders and other subdirectories. Messages are concatenated in the
order they are saved.

10.1.2 Converting Mail Using the Mail Conversion Utility

The mailcv utility is a command line interface that you can use to convert
an entire directory or an individual folder. There are several flags available
that you can use to control how mail is converted. In addition, the mailcv
utility can be used to detect errors that may have occurred when you stored
messages. See the mailcv(1) reference page for information about the mail
conversion utility.

By default, all messages created by the dxmail application are converted,
including any corrupt messages. See Section 10.1.2.4 for information on
corrupt messages.

10.1.2.1 Converting an Entire Mail Directory

To convert an entire mail directory (folder) by using the mailcv utility:

1. Change to your top level mail directory. By default, this is $HOME/Mail.

2. Type the mailcv command with the -A flag to specify that you want to
convert the entire directory and subdirectories. You must specify the
current directory name and the name of the new directory that is to be
created as follows:

% mailcv -A $HOME/Mail $HOME/NewMail

This example creates a new top level directory called NewMail. It
then creates the subdirectories that correspond to the dxmail folder
structure and all mail messages are converted.
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10.1.2.2 Converting an Individual Folder

To convert an individual folder using the mailcv utility:

1. Change to the directory that contains the MH folder and message files
you want to convert.

2. Type the mailcv command with the -f flag to specify that you want to
convert a folder to the UNIX From format. You must specify the current
name of the folder followed by a new name for the folder as follows:

% mailcv -f inbox Inbox

This example creates a new folder called Inbox. If a new folder name
is not specified, a new folder is created using the name of the current
folder followed by the extension .mbe.

If the folder you are converting contains subfolders, the subfolders
are not converted. Use the steps described to convert each folder or
subfolder.

10.1.2.3 Using Flags to Control Mail Conversion

The mailcv command offers several command flags that you can use when
converting mail folders and directories. The flags are described in detail in
the mailcv reference page.

Using the mailcv command, you can specify flags to:

• Stops the conversion of a folder if a corrupted message is found. A
message is corrupted if it is missing one of the primary RFC 822 headers
that include: From, Date, and Reply-To. An error message is displayed
indicating the number and folder name of the corrupted message and
no further messages are copied into the folder.

• Delete MH/dxmail folders and messages after they have been converted.
However, if the folder contains other messages not in MH format, the
folder is not deleted.

• Skip over any corrupt messages and continue with the conversion of
messages that have the correct mail headers.

• Write to standard output the folder and message number that is being
converted.

10.1.2.4 Converting Corrupt Mail Messages

If you do not use the mailcv utility with the flags that handle corrupted
messages, the messages headers are converted as follows:

• From field is set to USER@UNKNOWN

• Date field is set to Mon, 01 Jan 1999 09:00:00 -000
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10.1.3 Converting Mail Using the File Manager

The CDE File Manager provides a graphical display of directories and files.
Using the CDE File Manager, you can convert the whole mail hierarchy
or you can convert a single folder.

Although the CDE File Manager calls the mailcv utility to complete the
conversion, it does not provide you the option of specifying flags to detect
mail header errors. To detect errors before converting your mail directories,
use the mailcv utility’s command line interface. If you do not address
corrupt files, the corrupt files are converted as described in Section 10.1.2.4

10.1.3.1 Converting the Entire Mail Hierarchy

To convert the entire mail hierarchy from the CDE File Manager:

1. Start the CDE File Manager.

2. Change to the directory that contains the MH folders to be converted.

3. Point to the MH mail folder icon, then click on mouse button 3 to
display the Action menu.

4. Select the Mail Convert menu item from the Action menu. A dialog
box appears. You must enter a new pathname for the new directory
hierarchy. Click OK after entering the new directory name.

After you select a new location for the directory hierarchy, the mailcv utility
begins the conversion. Depending on the size of the mail hierarchy, the
conversion may take some time. When it is complete, your mail is accessible
from the CDE mail application.

10.1.3.2 Converting an Individual Folder

To convert a single folder from the CDE File Manager:

1. Start the CDE File Manager.

2. Set your path to the MH pathname where the top level mail directory
is located. Use the mhpath command with the + flag if you are unsure
of the location.

____________________ Note _____________________

To use the mhpath command, the MH subsets must be
installed on your system.

After setting your path, the CDE File Manager displays the Mail
directories (folders). Each is represented by an icon.
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3. Change to the folder that you want to convert.

4. Select the Mail Convert menu item from the Action menu. A dialog box
appears. You must enter a new folder name for the new folder. Click
OK after entering the new name.

After you select a new location for the folder, the mailcv utility begins the
conversion. Subfolders in the folder you are converting are not converted.
Depending on the size of the folder, the conversion may take some time.
When it is complete, your mail is accessible from the CDE mail application.

10.2 Converting Calendar Databases

The dxcaltodtcm application converts a calendar database file that has
been created with the dxcalendar application to a format that can be used
by the CDE calendar application, dtcm.

To convert a dxcalendar database:

1. Invoke the dxcalendar command with the -migrate option.

$ dxcalendar -migrate

A text file called $HOME/dwc_db_migration.data is created. This
file contains your calendar entries.

2. Run the CDE Calendar application, dtcm, and set the hour display to 12.

3. Invoke the dxcaltodtcm application to read the created text file and
add the entries to the CDE calendar database.

The dxcalendar command is in /usr/bin/X11 and the dxcaltodtcm
command is in /usr/dt/bin.

______________________ Note _______________________

Because some features of the DECwindows Calendar are
not available in the CDE Calendar, some loss of information
is possible in converting a calendar database. See the
dxcaltodtcm(1) reference page for a list of restrictions.
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A
Differences in Mail Handlers

There are differences in how the CDE mail application and the DECwindows
Motif mail application manage mail operations. This appendix discusses:

• Features present in the CDE mail application, but not present in the
DECwindows Motif mail application

• Absence of MH features in the CDE mail application

• Differences between MH/DXmail and the CDE mail applcation

A.1 Features Available in the CDE Mail Application
This section highlights some of the features available in the CDE mail
application that are not available in the MH/DXmail application:

• Provides minimal compliance for the Multipurpose Internet Messages
Extension (MIME) standard. See the Internet Message RFCs for a
description of MIME.

• Turns vacation notification on or off from within the dtmail application.

• Provides a Spell Checker to check spelling when composing messages.

• Supports search and substitution of text when composing a message.

• Supports use of templates (composed text) that you can include in mail
messages.

• Offers a Comprehensive Options dialog box that you can use to do the
following:

– Set aliases

– Specify predefined headers during compose

– Specify the removal of headers during read operations

– Set message numbers

– Indent an included message during a reply operation

– Set an auto log of send messages

– Specify a top level directory for mailfolders, and others files

• You can use the CDE Mailer as a Post Office Protocol (POP) client to
connect to network mail servers offering POP services. If you choose
this option, you can also select APOP authentication (if supported by
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your network mail server) to encrypt your user ID and password during
communications with your mail server.

A.2 Features Not Available in the CDE Mail Applications

The following list highlights some differences between the DECwindows
Motif mail and CDE mail applications:

• User’s view of folders

The dxmail application provides a window that lists all available
mailboxes (folders) for each user. The dtmail application does not
provide this feature. To view mail folders under CDE, you must use the
File Manager. Thus, if you maintain your mail in one directory, you can
use the features of the File Manager with dtmail to open folders and so
forth, or manage your mail directories. See the CDE User’s Guide for
information on the File Manager and using datatypes.

• Personal Editors

The dtmail application does not support the ability to specify an editor
of your choice when composing mail.

• Modifying read messages

The dtmail application does not provide the ability to modify a message
when in read mode. To modify a message, forward the message to
yourself. Then, in the Compose window, edit, then send the message.

• Signatures

The dtmail application does not provide the ability to specify a
Signature. The GECOS field specified in the /etc/passwd file is used
instead.

A.3 Differences Between MH and the CDE Mail Applications

Unlike the dtmail application, the dxmail application uses the Rand
Corporation Mail Handler (MH) to process mail. Table A–1 lists the
availability of MH attributes in the CDE mail application.

Table A–1: Differences in Mail Handlers
MH Command Use of Command Available in CDE

Mail

alex Extracts addresses from message headers No

ali Lists mail aliases Yes

anno Annotates messages No

ap Parses addresses RFC 822-style Yes
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Table A–1: Differences in Mail Handlers (cont.)

MH Command Use of Command Available in CDE
Mail

burst Explodes and digests into messages No

comp Composes a new message Yes

conflict Searches for alias/password conflicts No

dist Redistributes a message to additional
addresses

Yes

dp Parses dates RFC 822-style Yes

folder Sets or lists current folder/message Yes

forw Forwards message Yes

inc Incorporates new mail Yes (reads new mail)

install-mh Initializes the MH environment No

mark Marks messages No

mhl Produces formated listings of MH messages No

mhmail Sends or reads mail Yes

mhpath Prints full pathnames of MH messages
and folders

No

msgchk Checks for messages Yes

msh Starts MH shell Not applicable

next Shows the next message Yes

packf Compresses a folder into a single file Not applicable

pick Selects messages by content Partially available

post Delivers a message Yes

prev Shows the previous message Yes

prompter Prompting editor front end No

rcvstore Incorporates new mail asynchronously Not applicable

refile Files messages in different folder Yes

repl Replies to a message Yes

rmf Removes a folder No

rmm Removes messages Yes

scan Produces a scan listing that has one
line per message

Yes

send Sends a message Yes
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Table A–1: Differences in Mail Handlers (cont.)

MH Command Use of Command Available in CDE
Mail

slocala Receives mail hooks Yes

show Shows (lists) messages Yes

sortm Sorts messages Yes

whatnow Prompting front-end for send No

whom Reports who receives a message when sent No
a Available only if the MH subset is installed.
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